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1 INTRODUCTION
1.1 ABOUT THIS MANUAL

This User's Manual explains the CLIO system hardware and CLIO 12 software.

All software versions are covered, please note that CLIO 12 software is designed to
operate in conjunction with the supplied PC hardware. If the hardware is absent or
the serial numbers do not correspond then CLIO 12 will operate in demo mode
only.

1.1.1 WHAT THIS USER MANUAL DOES COVER

The CLIO System is a complete electro-acoustic analyzer. There are thousands of
books on many of the topics that CLIO handles as a measurement system. The
simple definition of Frequency Response could be extended to a book itself. This
User Manual is intended only as a guide to allow the user to quickly become
efficient in using the CLIO system, its user interface, its hardware features and
limits.

There is an important reference [1], 'Testing Loudspeakers' by Joseph D'Appolito,
which, in our opinion, is the perfect complement of what is covered here. Anyone
who feels that WHY and HOW is strongly related should seriously consider buying
this wonderful book.

1.2 GENERAL CONDITIONS AND WARRANTY

THANKS

Thank you for purchasing your CLIO system. We hope that your experiences using
CLIO will be both productive and satisfying.

CUSTOMER SUPPORT

Audiomatica is committed to supporting the use of the CLIO system, and to that
end, offers direct support to end users. Our users all around the world can contact
us directly regarding technical problems, bug reports, or suggestions for future
software enhancements. You can call, fax or write to us at:

AUDIOMATICA SRL
VIA MANFREDI 12
50136 FLORENCE, ITALY
PHONE: +39-055-6599036
FAX: +39-055-6503772

AUDIOMATICA ON-LINE

For any inquiry and to know the latest news about CLIO and other Audiomatica’s
products we are on the Internet to help you:

AUDIOMATICA website: www.audiomatica.com
E-MAIL: support@audiomatica.com

1 INTRODUCTION 9



AUDIOMATICA’S WARRANTY

Audiomatica warrants the CLIO system against physical defects for a period of one
year following the original retail purchase of this product. In the first instance,
please contact your local dealer in case of service needs. You can also contact us
directly as outlined above, or refer to other qualified personnel.

WARNINGS AND LIMITATIONS OF LIABILITY

Audiomatica will not assume liability for damage or injury due to user servicing or
misuse of our product. Audiomatica will not extend warranty coverage for damage
of the CLIO system caused by misuse or physical damage. Audiomatica will not
assume liability for the recovery of lost programs or data. The user must assume
responsibility for the quality, performance and the fitness of Audiomatica software
and hardware for use in professional production activities.

The CLIO SYSTEM, CLIOfw, CLIOQC and AUDIOMATICA are registered trademarks
of Audiomatica SRL.

10 1 INTRODUCTIONCLIO 12 QC - USER'S MANUAL
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PHONE NUMBER:
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1 INTRODUCTION

11



2 THE CLIO SYSTEM

Depending on the hardware options that have been purchased, the CLIO system
consists of the following components:

- The FW-02 USB interface

- The MIC-01 or MIC-02 or MIC-03 or MIC-04 microphones

- The PRE-01 microphone preamplifier

- The QCBox Model 5 power amplifier, switching and testing box

In the next few pages we will describe each component and give its respective
technical specifications.

NOTE: Audiomatica reserves the right to modify the following specifications without
notice.
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2.1 THE FW-02 USB INTERFACE
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The FW-02 USB Interface sets new hardware precision standards for the CLIO
System. The FW-02 unit has been designed to be a complete two channels
professional A/D D/A audio front-end for your PC; it is connected to the computer
using a USB 2.0 port giving you maximum performances. The FW-02 performances
(24 bit @ 192 kHz) represent state-of-the-art measurement capabilities for any
audio device or acoustical test. The FW-02 is equipped with an instrument grade
balanced input and output analog circuitry with an exceptionally wide range of
output attenuation and input gain that allows an easy interface to the outer world;
the input and output loopback capability with the internal ultra stable voltage
reference permit a simple and precise calibration of the whole instrument. A
switchable phantom power supply lets you directly connect an Audiomatica MIC-01,
MIC-02, MIC-03 or MIC-04 as well as any other standard balanced microphone to
any of the FW-02 input.

2.1.1 TECHNICAL SPECIFICATIONS

GENERATOR

Two channels 24 Bit sigma-delta D/A Converter
Frequency range: 1Hz-90kHz

Frequency accuracy: >0.01%

Frequency resolution: 0.01Hz

Output impedance: 6600hm

Max output level (Sine):17dBu (5.5Vrms)
Attenuation: 0.1 dB steps to full mute
THD+Noise(Sine):0.008%

Digital out: SPDIF

ANALYZER

Two channels 24 bit sigma-delta A/D Converter
Input range: +40 + -40dBV

Max input acceptance: +40dBV (283Vpp)

Input impedance: 128kOhm (5.6kOhm mic)
Phantom power supply: 24V

PC SYSTEM RESOURCES

One free USB 2.0 port

MISCELLANEOUS

Sampling frequencies: 192kHz, 96kHz and 48kHz.
Connections: analog 2 XLR combo in, 2 XLR plus 2 RCA out, 1 RCA digital out
Digital connection: USB type B

Power supply: External 12V DC (AC adapter supplied)
Dimensions :16(w)x17(d)x4(h)

Weight: 0.8 kg

14 2 THE CLIO SYSTEMCLIO 12 QC - USER'S MANUAL



2.2 THE MIC-01, MIC-02 AND MIC-03 MICROPHONES

e
L

2.2.1 THE MIC-01 MICROPHONE

The MIC-01 microphone is an electret measuring microphone that is particularly
well suited to being used in conjunction with the other components of the CLIO
system. It is furnished with a 2.7m cable, a stand adapter, a 1/2” calibrator adapter
and a calibration chart reporting the individually measured sensitivity, all fitted in
an elegant plastic case. Its long and thin shape renders it ideal for anechoic
measurements. Because its frequency response is very flat over the entire audio
band, no particular correction is usually needed.

2.2.2 THE MIC-02 MICROPHONE

The MIC-02 microphone is functionally identical to MIC-01. It differs only in the fact
that its length is 12 cm instead 25 cm. The MIC-02 is more practical to handle and
to work with, and is ideal for measurements in a reverberant environment.

2.2.3 THE MIC-03 MICROPHONE
The MIC-03 microphone is functionally identical to MIC-01. It differs only in the fact

that its length is 7 cm instead 25 cm. The MIC-03 is more convenient where space
saving is a must.
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2.2.4 TECHNICAL SPECIFICATIONS

MIC-01
Type: Condenser electret
Accuracy: +1 dB, 20 Hz to 10 kHz
+2 dB, 10 kHz to 20 kHz (direct field)
Maximum level: 130 dB SPL
Dimensions: 8 mm diameter, 25 cm long
Accessories: case, 2.7 m cable, stand adapter, 1/2” calibrator adapter
MIC-02: Same as MIC-01, but 12 cm long.
MIC-03: Same as MIC-01, but 7 cm long.

Polar Response:

MIC-01-MIC-02-MIC-03
2.2.5 THE MIC-01 (OR MIC-02) FREQUENCY CALIBRATION DATA

r Free-field Microphone 50 i
11] Type MIC 02 -
AT, Calibration Chart
) 0.0
Serial No: 9202011
Sensitivity: -35.3  dBre 1V/Pa
) 17.24 mV/Pa
Valid at: -50
Temperature: el "
rbient Static Pressure: 020 kPa
=lative Umidity: 47 o
Frequency: 1000 Hz -10.0)
Pelarization Cenditons: 8258 V-KOhm
Reference Instruments:
MANUF. MODEL  SERIALNO CALIB. DATE
HP a4e3s  2iaTansdal 20082002 150
LARSON DAVIS 812 418
BAK 423 1758543 0-0
BAK 4039 2345912 05-03-200
- 200
Date: 10/1 52003 Cerificate NO: 3315 Signature : M.J. 20 100 1k 10k Hz 20k

| | _

The microphones MIC-01 and MIC-02 can be furnished, at a separate cost, with a
frequency calibration certificate. This document, along with numerical data on disk,
is released by Audiomatica and specifies the frequency behavior of the single
microphone under test. The data can be used with the CLIO software (5.4.2).

2.2.6 THE MIC-04 MICROPHONE

It is possible to get the same characteristics of our range of microphones in a
particular housing, rugged and space savings, for production line QC application.
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2.3 THE PRE-01 MICROPHONE PREAMPLIFIER

The microphone preamplifier PRE-01 has been designed to match Audiomatica’s
microphones MIC-01, MIC-02, MIC-03 or MIC-04. It is particularly useful when the
microphone has to be operated far from the analyzer or when weighted
measurements are needed. PRE-01 powers the microphone connected to its input
with an 8.2V phantom supply and adds a selectable weighting filter (A or B or C);
also available there is a 20 dB gain stage. The unit is operated with one standard
9V battery or with an external DC power supply.

2.3.1 TECHNICAL SPECIFICATION

Frequency response: 7Hz+110kHz (-3dB)
Weighting filter: A, B, C (IEC 651 - TYPEI)
Phantom power supply: 8.2V (5600 Ohm)

Gain: 0 & 20dB (INTERNAL SETTINGS)
Input impedance: 5600 Ohm

Output impedance: 100 Ohm

Maximum output voltage (@1kHz): 25 Vpp

THD (@1kHz): 0.01%

Input noise (@20dB gain): 7uV LIN, 5.3uV A

Drive capability: +7mA

Batteries duration: >24h (alkaline cell)

Size: 12.5(w)x19(d)x5(h)cm
Weight: 900g

2.3.2 USE OF THE PREAMPLIFIER

The MIC-01 or MIC-02 or MIC-03 or MIC-04 microphone cable should be connected
to the preamplifier input while the preamplifier output requires connection to the
analyzer input. The unit is switched on with the POWER switch, while the TEST
push-button controls the state of the unit. Correct operation of the unit is indicated
by the led light being illuminated, if the LED fails to illuminate then either the
batteries are low or the external power supply is not connected. The FILTER switch
inserts the weighting filter. To choose the desired weighting filter type and to set
the amplifier gain you have to modify the unit settings with the dip switch operated
from the back panel.

NOTE: if the 20 dB gain stage is inserted the overall sensitivity (microphone + pre)
is 10 times higher. For example if your microphone has a sensitivity of 17.1 mV/Pa
and you amplify it by 20 dB then you get a sensitivity of 171 mV/Pa.
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2.4 THE QCBOX MODEL 5 POWER AMPLIFIER, SWITCHING AND
TESTING BOX

g
y “ﬂﬂ
Al 4

The QCBOX Model 5 power amplifier, switching and testing box is of invaluable help
when configuring an automatic or manual quality control setup, or even in everyday
laboratory use.

It can be configured, under software control via USB, to assist frequency
response and impedance measurements or to perform DC measurements.

Between its features is the possibility of internal switching that permits the
measurement of the impedance and frequency response of the loudspeaker
connected to its output sockets without changing the wiring to the speaker; it
is also possible to route one of four inputs for the response measurements; these
input have powering for a microphone (0+24V variable).

An internal ADC measures the DC current into the voice coil; an over current limiter
is available to a predefined threshold. Thanks to an internal software controlled
voltage generator the speaker can be driven with a superimposed DC voltage
(£20V max), allowing for measurements of large signal T&S parameters. Two ADC
converters with a £2.5V and £5V are available at inputs 3 and 4 to measure the
displacement with a laser sensor or any other DC signal.

A dedicated output, ISENSE, allows impedance measurements in constant voltage
mode as well as voice coil current distortion analysis.

A 5 bit in - 6 bit out digital port is available to interface the QCBOX with external
hardware or line automation. An ulterior dedicated input permits an external foot
pedal switch to be connected and trigger QC operations.

N N\
& QCBOX MODEL 5 A (®))
— O
- INPUT N ( r \‘ ‘/ ’ \\: B AUDIOMATICA
Y N 7Y me N NSNS 7N N N
(o] J N S=ER NS D.U.T N / NEZEEN
N/ o >/
o1 2 3 4 ) ISENSE TOCLIO  FROMCLIO
N QCBOX MODEL 5 POWER AMPLIFIER, SWITCHING & TESTING BOX o ™ —
=/ [ usB DIGITAL 1/0 PEDALIN ) = = =
—~ CAUTION (O) Q) Acrower
c € I () SHOCKHAZARD | ] o
“—  |REFERSERVICETO \__ / e
— QUALIFIED .
(@) RN ) PERSONNEL E (O))
NS MADE IN ITALY BY AUDIOMATICA SRL N
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MECHANICAL ASSEMBLIES

19” RACK MOUNT ASSEMBLY

Using the Rack QC panel it is possible to assemble the QCBOX Model 5 together the
FW-02 Audio Interface so that they can be mounted in a standard 19” rack frame.

S e - © @ . o0
o ooognn OO

EEEEEEEEEEEE FROM CLIO

FW PANEL MOUNT ASSEMBLY
Using the FW panel it is possible to assemble the QCBOX Model 5 together the FW-
02 Audio Interface in a convenient way for laboratory use.

© ©

©

@ e}
6O 00000 O

ISENSE TO CLIO FROM CLIO

2.4.1 TECHNICAL SPECIFICATIONS

Inputs: Four line/microphone inputs with
selectable phantom power supply (0+-24V variable)
One TTL input for external trigger
5 digital lines

Outputs: Isense
6 digital lines

Functions: USB controlled internal switches for impedance
and DC measurements

DC measuring: Isense current £2.25 A
DCIN 3 2.5V
DCIN4 £5V

Power output stage: 50W (80hm) with current sensing and overcurrent protection
Possibility of superimposing a DC voltage (£20 V)

THD (@1 kHz): 0.004 %
Dimensions: 23(w)x23(d)x4(h)cm
Weight: 1.4kg

AC: 90+240V
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3 CLIO INSTALLATION
3.1 MINIMUM PC CONFIGURATION

The CLIO FW-02 USB interface running the CLIO 12 software can be installed in any
personal computer with the following minimum system requirements:

- Processor: single-core @ 2GHz clock or dual-core (suggested)

- One free USB 2.0 port

- 1024x786 video adapter

- Microsoft Windows XP, Vista, 7, 8 or 10

BE SURE TO HAVE ADMINISTRATIVE RIGHTS WHEN INSTALLING!

3.2 FW-02 DRIVERS INSTALLATION

To install the FW-02 drivers in your computer you should follow the instructions
presented below:

1) Connect the FW-02 to a free USB 2.0 port on your PC and power it with its 12V
supply. You should hear the classical sound of plug and play devices.
NOTE: ClioXP is the nickname of the FW-02 device seen by Windows.

Device Setup

Installing ClioXP

Please wait while Setup installs necessary files on your system. This may take

L several minutes,

2) After the initial automatic driver detection only one device should be found amd
properly installed by Windows, the USB Composite Device; two more devices,
named ClioXP will need to be installed manually. Open Device Manager (type
devmgmt.msc from Run prompt or click Control Panel>System>Device
Manager); you should find this situation:
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;.l.; Device Manager
File Action View Help

e @ H=EE

v & AudMacMini

I Audio inputs and outputs
@ Bluetooth

[ Computer

- Disk drives

& Display adapters

== |IDE ATA/ATAPI controllers
i |EEE 1354 host controllers
:i‘: Imaging devices

@ Mice and other pointing devices
[ Monitars
? Metwork adapters
v B? Other devices
Bi ClioXpP
Bi ClioXp
@ Portable Devices
M Print queues
™ Printers
I Processors
B Software devices
i Sound, video and game controllers
Sy Storage controllers
K@ System devices

M |Inivercal Serial Rie rantrollers

3) Insert the CLIO 12 installation CD-ROM in the PC.

4) Right-Click on each ClioXP device under Other Devices and choose Update Driver

Software. At the successive prompt:

B Update Driver Software - ClioXP

How do you want to search for driver software?

— Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

—> Browse my computer for driver software
Locate and install driver software manually.

Cancel

5) Browse your computer and point to the folder inside the installation CD where

the proper drivers are located (for example \Driver\10).
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Browse For Folder >
Select the folder that contains drivers for your hardware.
N Drriver -
v 10
v ClioXP Driver v2.12.18 WHOL
amdbd
i386
Static
Vista_7_8
P v
Folder: 10
Cancel

Ignore any Microsoft's warning message about Digital Signature or Publisher and

reach the end of the wizard.

B Update Driver Software - CligXP Control
Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

ClicXP Control
g

Close

B Update Driver Software - ClioXP Stream
Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

ClioXP Stream
E g

Close

6) Inspecting again the Device manager confirms you the proper ClioXP Control and

ClioXP Stream entries under USB controllers category:

3 CLIO INSTALLATION
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& Device Manager - O >
File Action View Help

as | F E HE B BEX®

= Printers A
[ Processors
B Software devices
i Sound, video and game controllers
Cu Sterage controllers
K@ System devices
w ' Universal Serial Bus controllers
§ ClioXP Control
i ClioXP Stream
§ Generic USB Hub
§ Generic USB Hub
i Generic U5B Hub
§ Generic USB Hub
i Generic U5B Hub
§ Intel(R) 7 Series/C216 Chipset Family USE Enhanced Host Controller - 1E2D
i Intel(R) 7 Series/C216 Chipset Family USE Enhanced Host Contraller - 1E26
i Intel(R) USBE 3.0 eXtensible Host Controller - 1.0 (Microsoft)
i USB Composite Device
§ USB Composite Device
i USB Composite Device
i USBE Mass Storage Device
§ USB Root Hub
i USB Root Hub
§ USB Root Hub (xHCI)
= WSD Print Provider

Your driver installation was successful!
3.3 FW-02 DRIVERS INSTALLATION UNDER WINDOWS XP

1) Connect the FW-02 to a free USB 2.0 port on your PC and power it with its 12V
supply. You should hear the classical sound of plug and play devices.
NOTE: ClioXP is the nickname of the FW-02 device seen by Windows.

2) The Found New Hardware Wizard detects the CLIO XP device:

j\_,} Found Mew Hardware

ClicxP

As the CLIOXP drivers are unknown to Windows you will be prompted with this
search window:
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Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
“windows will search for current and updated software by

looking on your computer, on the hardware installation CD. ar on
the Windows Lpdate Wieb site [with your permizzion)

Bead our privacy policy

Can'windows connect to ‘windows Update to search for
software?

(O Yes, this time orly
() ez. now and every time | connect a device
(&) Mo, not this time

Click Next to continue.

Found New Hardware Wizard

Thiz wizard helps you install saftware for:

ClickF

{ -) If your hardware came with an installation CD

\_

g2 or floppy disk, inzert it now.

what do you want the wizard to do?

() Install the software automatically [Fecommended)
(=) Install from a list or specific location [dvanced)

Click Next to continue.

[ < Back " Next > ][ Cancel

3) Insert the CLIO 12 installation CD-ROM in the PC.
Search in the proper CD folder (for example Drivers\XP)

Found New Hardware Wizard

Please choose your search and installation options.

() Search for the best driver in these locations

Use the check boxes below ta limit or expand the default search, which includes local
paths and remavable media. The best driver found will be installed.

[[] 5earch removable media [floppy, CO-ROM...]
Include this location in the search:

E\Driver{PACIP Driver v2,08.24 v

() Don't search. | will choose the driver to install

Chooze thiz option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware

< Back ][ Nexst > ]I Cancel

5) Do not stop to Microsoft Warning about Windows Logo testing.
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Har dware Installation

| E The zoftware you are installing for this hardware:
-
CligsP Stream

has not passed Windows Loga testing to verify its compatibility

with windows *P. [Tell me why this testing is important. ]

Continuing your installation of thiz software may impair
or destabilize the correct operation of your spstem
either immediately or in the future. Microsoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
paszzed Windows Logo testing.

’ Continue Angway ] [ STOPR Installation l

6) Open Device Manager (type devmgmt.msc from Run prompt or click Control
Panel>System>Device Manager); you should find this situation:

£ Device Manager

File  Action Wiew Help

& 2m &

CODEQLD
_J Compuker

g Dishk drives

j Display adapters

i DVD/CD-ROM drives

8 Human Interface Devices

+-i=) IDE ATAMATAPT controllers

+| - IEEE 1394 Bus host controllsrs

+| -z Keyboards

+- ") Mice and other pointing devices
+-® Maritors

+- B8 Metwork adapters

+ - Ports (COM & LPT)

+ ﬂ Processors

+- @, Sound, video and game contrallers

+ System devices
= é Universal Serial Bus controllers
& ClioxP Control
o CliokP Stream
= Standard Enhanced PCI b USE Host Conkroller
= Standard Universal PCI ko USE Hosk Controller
= Standard Universal PCI ko USE Hosk Controller
= Standard Universal PCI ko USE Hosk Controller
= Standard Universal PCI ko USE Hosk Controller
USE Cormposite Device
USE Cormposite Device
USE Cormposite Device
USE Prinking Support
USE Prinking Support
o USE Root Hub
o USE Root Hub
o USE Root Hub
o USE Root Hub
o USE Root Hub
= USE Serial Converter

- - - )

Your driver installation was successful!
3.5 SOFTWARE INSTALLATION

This paragraph deals with software installation.

Be sure to have administrative rights when installing CLIO.

The CLIO software is provided either on its own CD-ROM, SD card or, in electronic
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format, as a single, self-extracting, executable file.

To install the CLIO 12 software in your computer you should follow the instructions
presented below:

1) Insert the CLIO 12 CD ROM in the computer.

& | |ﬂ =1 Drive Tools  DVD Drive (E:) 6017160037 QC = O *
Home Share View Manage o

“— v P » ThisPC » DVD Drive (E:) 6017160037 QC v | O Search DVD Drive (E:) 6017160... 0
|| Documents ol Driver
&= Pictures I_'| G017160037.qc.id
ClioPkt.mb A cLI0_1200_QC_6017160037
Delphi? B ReadMe
H+V

Presentazioni AE
‘@ OneDrive

[ This PC

[ Desktop

|‘:f| Documents
‘ Downloads

J’) Music

&=/ Pictures

B Videos

i BOOTCAMP ()
& (D)

DVD Drive (E:) &0
v

4 items = =

3) Choose CLIO 12 installer to start installation.

[ CLIO 12.00 OC Setup - X 4 CLIO12.00 QC Setup - X
y 1 (@) !
Welcome to the CLIO 12.00 QC C I 2
Setup Wizard - —
This wizard wil guide you through the installation of CLIO Setup wil install €LIO 12.00 QC in the follawing folder. To install in a different folder, cick
12.00 QC. Browse and select another folder. Click Next to continue.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.
Destination Folder

Browse...

Space required: 20.5MB
Space available: 91,2GB

The procedure is completely automatic and will only request you to accept the
Software End User's License Agreement and input some information in order to

correctly install CLIO 12; the software installer will also check your operating
system version.

After successfully completing this procedure take note of the installation directory

of CLIO (usually C:\Program Files\Audiomatica\CLIO12 or C:\Program Files
(x86)\Audiomatica\CLIO12 ).
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3.6 RUNNING CLIO FOR THE FIRST TIME

If you have completed the preceding installation procedure, you are ready to run
CLIO!

3.6.1 THE 'CLIO BOX' AND CLIO SERIAL NUMBER

A few words about the FW-02 USB interface.

This unit is needed to correctly interface analog signals to your PC; it is also
important as it has an internal reference used to calibrate the system and also
stores the system's serial humber inside its internal EEPROM; Figure below shows
where is located your CLIO system serial humber.

The CLIO serial number is very important and should be mentioned each
time you get in contact with Audiomatica, either for technical support or for
software upgrade.

Also the CLIO system accessories have their serial numbers; keep track of those
but mention to technical support ONLY UPON REQUEST.

When using your CLIO system you will normally use the FW-02 front connectors. As
you'll become extremely familiar with this hardware unit we are going to give it a
nickname: from now on we will call it 'the CLIO Box'. Also the CLIO software
refers to it with this nickname.
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3.6.2 THE FIRST RUN

The following steps will guide you through a complete verification of the
system performance and operation.

From the Start Menu choose Programs, then CLIO 12 and click on the CLIO icon.

The program should start smoothly and present the main desktop.

CUO 12 - ELECTRICAL & ACOUSTICAL TE:

_=|¢J I EHEO® = O @ Si|mc>wm\mumaﬁWFLaqxmeRQc|§|uﬂ

Autoscale

N/ NN /) =
File&Print operations Desktop control Measurement Analysis P

Options
Main Menu bt

Temperature
Sampling Frequency

Input Peak Meter Input Sensitivity display & control Output Level & Generator
/ )i ﬂ\ In-Out Loop / \ QCBOK Turntable

Input A dBfs InputB  dBfs
= odav A |

o 0dBY 4 a8 A& | ¢a ¢ out 1000V v o ¢ v|(ﬂ (68| @ @ 192kHz 34C

If the system is not calibrated, as the first time you run it, you will receive the
following message.

! SYSTEM MOT CALIBRATED

T

Should CLIO display an error message take note of it and go to the troubleshooting
section.

3.6.3 INITIAL TEST MEASUREMENT

Let's now execute our first test measurement - play and capture a 1kHz sinusoid.

First of all click on the In-Out Loop ¢ putton for channel A; in this way the CLIO
Box connects output A with input A with an internal relay. This connection is very
important as it lets you capture and analyze a sighal generated by CLIO without the
need for an external connecting cable.

Then click on the generator icon ¢ to play the 1kHz sinusoid (1031.25Hz to be
exact; more on this later, it's the default signal). Then press the F4 keystroke to
invoke the Multi-Meter as in Figure.
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-‘leuH[ﬁ““‘«—»‘E‘U\ X | (S A B ) )

e Multi-Meter (=8 R
= Voltage v RMS X ~ CHA | Fast ~— v - v % X
g
1.006
000 0% o’ 0o 00 100
Filename: RUNNING
oAt 0By [t e Todpy a8 | & ‘ GE Out 1000V v + @) | (r (6| @ 48kHz 3C

If everything is OK you should obtain a reading of circa 1V, variable between a
minimum of 0.95V and a maximum of 1.05V, which is the mean output level of a
sinusoidal signal when the system is not calibrated.

Now press the FFT '/ button (or CTRL-F), then press the Oscilloscope button and
finally the P GoButton.

= v HH@QL_,\E\JC%|m®4x\mNA5wqu/mmlRQ<\y\
P |[w]) ] w55 [[3] & [Rectanguar | oA | a8V [ussmootned | 1 1
- v & X @& @ o @ EO @ 5 [ I B O s = |
o
20
60
80
100
10 20 50 10 200 500 1k 2k Hz Sk 10k 20k
- -+z aa @@
\; TAY Va\ a¥ . A
\ \ \ A /3 [\ TR THN / / [
9 \ J/ERY JI A [T [ JHR) R [ T\ [ I\ Il
| Y N Y VAN N Y A VY A Y Y VY I VY O A WY |
Y 220 N N VA N VA N VO A Y A VA VY O 0 . VY A Y
\ \ ] \ ] / \ ] \ \ ] \ ] \ ] A
12 \/ \/ AW \/ v/ \/ \/ \/ \ ] \/
v I A Y % Ao 1 v 7
2E| 1.00 20 30 40 50 B0 70 80 ms. 3.0 100
Fiename CHA dBY 48z 16364 203Hz Rectangular Unsroothed
noth e [0y - |'pet e Togey | as| & [ s our 1000V v o @ - < 8| @ @ |askHz] 38C

The result you should obtain is an FFT analysis of the 1kHz sinusoid (one spectral
line @ 1kHz at 0dBV) and its time representation given by its oscillogram.

Both Multimeter and FFT results must present stable and repeatable; the
oscillogram should display a sinusoid without spikes or drops of any kind.

IMPORTANT NOTE: Only if these two initial tests gave correct results, as
described, go to the following paragraph and execute the system calibration; if you
are not able to obtain these results and they seem in any way corrupted do not
execute calibration and contact technical support.
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3.7 SYSTEM CALIBRATION
This section describes how to perform the system calibration.

Be sure that, any time you perform a calibration, the system has warmed up for, at
least 15-20 minutes.

Select Calibration from the Main menu ;

J"Warning
b }
|
! The procedure will take several minutes,
% Leaveinput and cutput on the CLICfw
Leave the CLIO Box front plugs unconnected. FRONT panel NOT CONNECTED

Do you want to proceed?

[ OK H Cancel |

Answer OK to the initial prompt; this will run an automatic procedure that will last
several minutes. The calibration procedure is completely automatic and several
progress indicators will accompany all the executed measurements. At the end of it
your CLIO system should be calibrated and ready to carry out measurements.

Progress indicator £

Proceeding with Level Calibration .....
Calibrating input gains

| ]
30%

Software won't allow calibration if internal temperature lies outside a
predetermined range (between 30 to 45 degrees).

So it is normal to receive a message like:

Information X

'.6.' Temperature too low for attempting Calibration

It is also normal to receive the following message:

Warning bt

Calibration failed

i

This is normally due to the calibration parameters that do not match the internally
stored parameters that have been measured at Audiomatica laboratory and that
ensure the highest precision of the instrument. In such a case either wait to repeat
calibration if instrument is too cold for it to warm, or wait for the device to cool if
too hot.

At the end of the calibration process it is always mandatory to verify the calibration
itself; this is done by two simple measurements as described in the following
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paragraph 3.7.1 CALIBRATION VALIDATION.

Only if this message appears consider to take proper action:

Error x
IQI Calibration failed

Calibration is a computer system resources demanding task.

Your computer would be best operated at high performance level:

33 Power Options — O >

« = ~ 4 @ » Control Panel » All Control Panel lterns » Power Options v Search Control Panel 2

Control Panel Home .
Choose or customize a power plan

Choose what the power A power plan is a collection of hardware and system settings (like display brightness, sleep, etc.) that manages
buttons do how your computer uses power. Tell me more about power plans
Create a power plan Preferred plans
&) g.holosewhen to turn off the (") Balanced (recommended) Change plan settings
Py Automatically balances performance with energy consumption on capable hardware.
% Change when the computer
sleeps () Power saver Change plan settings
Saves energy by reducing your computer's performance where possible.
Hide additicnal plans
(® High performance Change plan settings
Favors performance, but may use more energy.
Seealso
User Accounts

When using a notebook never run on batteries, always hook it to AC mains, as
power saving schemes greatly reduce performances. As ultimate resource these are
Recommended Advanced Power Settings, i.e. set 100% the Minimum processor
state:

& Power Options

Advanced settbngs

Select the power plan that you want to customize, and
then choose settings that reflect how you want your
computer 10 manage power.

Balanced [Active]

Wireless Adapter Settings Fy
Sleep
USB settings
Intel(R) Graphics Settings
Power buttons and lid
PCl Express
Processor power management
Maximum processor frequency
Minimum processor state
On battery: 5%
L =

System cooling policy

Restore plan defaults

OK Cancel Apply
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If you are not able to perform calibration please follow procedures given in 3.9
TROUBLESHOOTING CLIO INSTALLATION to get in contact with Audiomatica
technical support.

CLIO has been designed to give the user a high degree of precision, while
maintaining ease of use thus ensuring confidence in the measurements taken.
Calibration check plays a key role in all this. Note that, as calibration needs to be
performed under controlled conditions, calibration should be attempted the
least times possible; calibration, on the other side, should be verified as needed
or requested all the times the user wants following instructions given next;
verification, not calibration, of your hardware gives maximum confidence when
taking measurements.

3.7.1 CALIBRATION VALIDATION

To verify the calibration, first check that the generator output level is set to 1V
(refer to chapter 4 for details).

Press the channel A In-Out Loop button * .

Then click on the MLS&LogChirp button M to invoke the MLS&LogChirp control

panel. Press the Go P button to execute a LogChirp frequency response
measurement; after about 1 second you should obtain the desired result, a
straight line (black) as in Figure. You can click on the graph and inspect the
amplitude of the measured signal: you should obtain a reading around 0dBYV, this is
the correct output level of the LogChirp signal with the generator output set to 1V.

Now click on the Sinusoidal button - to invoke the Sinusoidal control panel as in

Figure. Press the Go P button to execute a Sinusoidal frequency response
measurement; after about 3 seconds you should obtain the desired result, again a
straight line (black) as in Figure. You can click on the graph and inspect the
amplitude of the measured signal: you should obtain a reading around 0dBV.

c CLO 12 - EL?TRICAL&ACDUSTICALTES
— & (AL — 2 o N =
:‘@j,,.‘HHEE"Eiu__|E/|Q‘;\ %"JI.I'LC)J\,\M’\JQQWFLEQ/WRLR Qc|§|l}_:‘)@
EX LogChirp - Frequency Response o |[= ] ==
P E =0 s 3 3L ’L‘ ] &3 CHA | @BV |Unsmasthed | o = ~ |0.000 |
- - %X [&] | om & B & 5 EM |
10 0]
dBY deg
0 108
-10
Ed sinusoidal [E=1ECR )
PE= s e g = | cHA | @BV | Unsmoothed |
=20
- - £ X [A] A om & m 4 5 il | |
10 =0
-30 dBv deg
a 108
40
10 20
-0 36
Filename:
-20 =36
-30 -108
-40 -180
10 20 a0 100 200 00 Tk Hz 2k Bk 10k 20k,
Filename: CHA dBV 1/6 Octave Unsmoothed 48kHz DelayCHA [ms]0.000 DelayCHB [ms]0.000 Distortion Ri:
InputA  dBfs Input B dBfs Iy
feuth o= | odBv o |putR B Cgamy & |as| & B ¢e out 1000V v « & | ga 8| @ amkHz| ITC
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To ensure a 100% correct calibration you also need to inspect the phase responses

of both measurements. To do this press the phase button ® and verify that you

obtain a straight line (red curves) the readings in this case should be around zero
degrees in both cases.

As a final test click on the In-Out Loop ¢* button for channel A; then click on the
In-Out Loop &* putton for channel B; then be sure that both input sensitivity are at

0dBV; click on the generator icon ¥ to play the 1kHz sinusoid; at last press the F4
keystroke to invoke again the Multi-Meter; the expected result is shown now.

C CLIO 12 - ELECTRICAL & ACOUSTICAL TESTS - m] x
S| PEEEE M S| @O ¢ R -| IO WA b (&) F e ) R o] & @ G
7] Multi-Meter =N e |
o] :‘ Q| Voltage v AMS ¥ -~ CHARB Fast — ~ « =~ % I
1.000 .
1.000 .
\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\
0o 040 020 1.20 1E0 200
Filename: RUMNING ...
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3.8 CLIO SERIAL NUMBER AND DEMO MODE

Each CLIO system has its own serial number which plays an important role since
the CLIO software is hardware protected and relies on a correct serialization in

order to run.

Refer to 3.6 to identify your system's serial number.

If the CLIO software doesn't find a CLIO Box with a correct serial number it gives a
warning message and enters what is called DEMO mode; in this way it is possible
to run CLIO in a PC where the CLIO hardware is not installed while still allowing you
to perform post-processing and other off line jobs.

3.9 TROUBLESHOOTING CLIO INSTALLATION

To receive assistance please contact Audiomatica at support@audiomatica.com or
connect to our website www.audiomatica.com.

NEVER FORGET TO SIGNAL PROPER SERIAL NUMBER OF YOUR CLIO!

When getting in contact with us please always send, as attachment to your email,
the System Info file of your CLIO system.

C CLIO 12 - ELECTRICAL & ACOUSTICAL TESTS

[ 5 File
Analysis L4
‘>)) Hardware Contrals 4
Cascade

Tile Horizontal

Tile Vertical

) Help 3 i) CLIOHelp F1

Recently Opened Files Help Language L4
Calibration ( @ On Line Technical Support

Exit On Line Resources Download

CLIO Home Page

Audiomatica Home Page

CLIO System Info

About

Credits

= | vHEHEOS| 2| O @ X -|

To create this file choose MainMenu>Help>SystemInfo. If your system has not
completed calibration create the system info file right after the calibration

has failed.
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4 CLIO BASICS
4.1 INTRODUCTION

This chapter gives you the basic information about CLIO and the related hardware
and how to connect and operate it, while the following chapters explain in more
detail the individual measurements available to users of CLIO. Chapter 5 deals with
other general functionality of CLIO.

Here you will find information about:
- Help
- Main desktop, toolbars and menu
- Shortcuts
- Generator, Input and Output, Microphone
- Amplifier & SwitchBox, Turntables
- Connections

4.2 GETTING HELP

'S €0 12 QC - USER'S MANL

File Edit View Window Help

@ Z & B @ | f s /209 | =) (o | :*"' s Tools = Sign Comment
@ Bookmarks IEHZ‘ —l
B~

[F CONTENTS =
={F 1 INTRODUCTION E
2{F 1.1 ABOUT THIS |

MENHAL ELECTRICAL & ACOUSTICAL TESTS
[ 1.1.1 WHAT THIS

USER MANUAL
DOES COVER

[ 1.2 GENERAL CLIO
CONDITIONS AND
WARRANTY

= 2 THE CLIO SYSTEM electrical and acoustical

2P 2.1 THE FW-02 USB e
INTERFACE

[P 2.1.1 TECHNICAL
SPECIFICATIONS

= 2.2 THE MIC-01
MICROPHONE

[ 221 THE MIC-02 ST - Automxnie

MICROPHONE u e

[P 222 THE mMIC-03
MICROPHONE CLIO Software

[ 223 TECHNICAL
SPECIFICATIONS Release 12

[F 224 THE MIC-01 Version Quality Control
(OR MIC-02)
FREQUENCY .
CALIBRATION User's Manual
DATA

[P 225 THE MIC-04
MICROPHONE
=P 2.3 THE PRE-01
MICROPHONE
PREAMPLIFIER
[ 231 TECHNICAL
SPECIFICATION

[ 232 USE OF THE
PREAMPLIFIER

AUDIOMATICA
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To request the CLIO on-line help press F1. The CLIO manual will be open by the
default pdf reader.

The CLIO help can be invoked also from outside CLIO; to do this go to the Start
Menu, then Programs, then CLIO12 and then click on 'CLIO Help'.

Another way to obtain help is through the Help Submenu which gives you the
possibility to view the on-line resources available in the Audiomatica and CLIO
websites.

Finally there are the dedicated buttons on the main toolbar.
2 Invokes the Help control panel.

@ Invokes the Internet On-Line Help.
4.3 CLIO DESKTOP

The CLIO desktop presents itself as in figure and gives you access to the (upper)
main toolbar and the (lower) hardware controls toolbar.

ﬁcuo 12 - ELECTRICAL & ACOUSTICAL TE! ; EE

S| VEHEHEOS| 2] O @ X-| QWD = (&) M bl [ 6w ] R| ] & g
N/ N / N s/ \m
File&Print operations Desktop control Measurement Analysis p

Autoscale
- Options
Main Menu
Temperature
Sampling Frequency
Input Peak Meter Input Sensitivity display & control Output Level & Generator
In-Out Loup QCBox Turntable
Mlc
InpulA dE\fso 0dBY L \nputE\ dE\IED 0dBv o | .L\El| |(+A B Qut  1.000V - A ‘ v| £4 (B ‘ & @ 192kHz 34 C

Inside the main toolbar and the hardware controls toolbar you can locate several
distinct functional areas as shown in the above figure. Now follows a description of
the Main Menu and all the controls inside the two toolbar.
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4.4 MAIN TOOLBAR & MAIN MENU

= The Main Menu is accessible clicking on the dedicated button on the main toolbar
or with the ALT-M shortcut.

L0 12 - ELECTRICAL & ACOUSTICAL TESTS

= vEEEE A ®|
e e >
Analysis 4
‘?):I Hardware Controls k
Window 4
l’:li Help 4

Recently Opened Files
Calibration

Exit

From top to bottom it gives you access to the File Submenu, Analysis Submenu,
Controls Submenu, Window Submenu and Help Submenu.

Then it displays a list of Recently Opened Files, there is the Calibration choice
and, finally Exit from the program.

4.4.1 FILE SUBMENU

Please refer to Chapter 5 for information about the File Submenu and its
shortcuts.

4.4.2 MEASUREMENT ANALYSIS BUTTONS & SUBMENU

By clicking on these toolbar buttons it is possible to interact and display each
measurement control panel. Once the toolbar button is clicked the appropriate
panel will be opened or reactivated. Any currently active panel will automatically be
deactivated on activation of the new one.

I Enters the MLS&LogChirp Analysis control panel.
)/ Enters the Directivity&3D Balloon control panel.
M Enters the Time Frequency Analysis control panel.
™ Enters the Acoustical Parameters control panel.
L/ Enters the FFT&RTA Analysis control panel.

"/ Enters the Sinusoidal Analysis control panel.
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“ Enters the Multimeter control panel.

\ Enters the Thiele&Small Parameters control panel.
¥F Enters the Wow&Flutter control panel.

"3 Enters the Leq control panel.

#Enters the Linearity&Distortion control panel.

"R Enters the Loudness Rating calculator.

“cEnters the Quality Control Processor.

The same functionality will be obtained with the relative shortcuts or by making a
selection inside the Analysis Submenu.

C CLIO12- ELECTRICAL & ACOUSTICAL TESTS
= vEEEHEO® 2O ¢ X
Il Fite »
|| Analysis ||| MLS & LogChirp Ctrl+M
‘J)) Hardware Controls ¥ ||| Directivity & 30 Balloons Ctrl+W
Window » || -h| Time Frequency Shift+ Ctrl+W
I@ Help » || ™| Acoustical Parameters & STl Ctrl+A
Recently Opened Files L | FFT & RTA Ctrl+F
| Sinuscidal Ctrl+5
Calibration o] s >
Bt .‘3' TE&S Parameters Ctrl+T
WE Wow & Flutter Crl+Alt+W
Leg| Leg Ctrl+L
#" | Linearity & Distortion Ctrl+D
L R | Loudness Rating Ctrl+R
Q| Quality Control Ctrl+Q

CTRL+M
Enters the MLS&LogChirp Analysis control panel.

CTRL+W
Enters the Directivity&3D Balloons control panel.

SHIFT+CTRL+W
Enters the Time Frequency Analysis control panel.

CTRL+A
Enters the Acoustical Parameters control panel.

CTRL+F
Enters the FFT&RTA Analysis control panel.

CTRL+S
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Enters the Sinusoidal Analysis control panel.

F4
Enters the Multimeter control panel.

CTRL+T
Enters the Thiele&Small Parameters control panel.

CTRL+AIt+W
Enters the Wow&Flutter control panel.

CTRL+L
Enters the Leq control panel.

CTRL+D
Enters the Linearity&Distortion control panel.

CTRL+R
Enters the Loudness Rating calculator.

CTRL+Q
Enters the Quality Control Processor.

4.4.3 CONTROLS SUBMENU
Refer below to Hardware Controls.
4.4.4 CALIBRATION

This option will perform a calibration of your CLIO hardware. Please refer to chapter
3 and follow the procedure described.

In order to determine, at any given time, if it is necessary to calibrate CLIO do the
following:

- Let the system warm up

- Proceed to perform the verification described

- Consequently decide whether or not to calibrate

The result of the measurement may vary in some way from the time we calibrated
because of many small changes in measurement conditions, including changes in
the atmospheric conditions, the season, and the mains voltage.

Note: the CLIO hardware is highly precise and stable and, under normal
operating conditions, does not require frequent calibrations.

Always perform a calibration if:

- CLIO asks for it showing the “"System Not Calibrated” message

- You reinstalled CLIO in a different computer

- You installed a software upgrade

4.4.5 AUTOSCALE

& Enables autoscale. When autoscale is active the software, during measurements,
determines the optimum Y-scale settings.
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4.5 HARDWARE CONTROLS TOOLBAR

Hardware controls are accessible either from the Hardware Controls Toolbar or
Submenu. The Toolbar is described in detail starting from left to right controls; the
Submenu is described when the keyboard shortcuts are needed.

4.5.1 INPUT CONTROL

Input A dBfs
-50 L0 channel A input peak meter
Constantly monitors channel A input signal level vs.full digital input scale.

- Controls channel A input polarity.

channel A input sensitivity display & control buttons

40 dBV
30 dBV
20 dBV
10 dBV
v 0dBY
-10 dBV
-20 dBY
-30 dBV

Input &  dBfs 0 dBV - B
50, .., . 0l (50, ...

Displays the actual input A sensitivity (in dBV) of the instrument, i.e. the voltage
level beyond which the hardware saturates. It is possible to modify it in 10dBV
steps choosing it or pressing the (F9) and/or (F10) buttons.

Input B dBf=z
S50 (L0 channel B input peak meter

Constantly monitors channel B input signal level vs.full digital input scale.

- Controls channel B input polarity.

channel B input sensitivity display & control buttons
Displays the actual input B sensitivity (in dBV) of the instrument, i.e. the voltage
level beyond which the hardware saturates. It is possible to modify it in 10dBV
steps choosing it or pressing the (F9) and/or (F10) buttons.

#B |inks input channels sensitivity controls. If this button is pressed the two
channel sensitivities are set equal and channel A controls act also on channel B.

"¥ Selects the Autorange mode. When in autorange mode the input sensitivity is

automatically adjusted by the instrument to achieve the optimum signal to noise
ratio.
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4.5.2 INPUT/OUTPUT LOOPBACK

The CLIO Box features an internal loopback which is very useful for performing self
tests.

‘-‘ﬁ Connects channel A output to channel A input with an internal relay.

‘39 Connects channel B output to channel B input with an internal relay.
4.5.3 GENERATOR CONTROL

CLIO's generator can be controlled from the dedicated toolbar buttons and dialogs;
for a reference about the possible kind of signal you may generate please see
chapter 7.

output level display & control buttons
Displays the actual output level (usually in Volts) of the internal generator. This
level is valid for both output channels. It is possible to modify it in 1dB steps

pressing the ¥ (F7) and “® or (F8) buttons. If the Shift key is pressed
simultaneously then the steps are of 0.1dB increments.

It is also possible to input a numeric value directly with the following dialog
which pops up when you click on the output level display.

Input Generator Qutput Level [-iﬂj

I Ok ] | Cahicel |

In this case (manual input) the output level will be approximated with a 0.01dB
precision. If you right-click on the output level display you invoke the out
units pop up from which it is possible to select the output level unit among dBu,
dBV, V and mV.

my
v ¥
dBV

dBu

Unbalanced

Out 1.000V QCBox

Checking the Unbalanced option the output level display is referred to the
unbalanced outputs of the Clio Box. When this mode is selected the generator
output level display is shown in white with black background.

E DutI:E:l:“ -
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Checking the QCBox option the output level display is referred to the
unbalanced outputs of the QCBox. When this mode is selected the generator
output level display is shown in black with red background.

B Out- v

When one of the output is muted (see below the associated shortcuts CTRL+F7
and SHIFT-CTRL+F7) this is reflected by a red color inside the Out box aside
the level display. If both output are muted the Out box background is totally red.

Mute CHA Mute CHB

e

W B Iut 1.000V

"))Switches on and off the generator.
Use the ESC key to immediately kill the generator .
If you wish to receive a confirmation message before playing the generator
then check the appropriate box in the CLIO Options>General tab (chapter 5).

Warning &J‘

i Start playing?

0K . Cancel
|

ALT-G It is possible to switch on the generator with this particular hot key; see
5.4.1 GENERAL settings.

generator drop down menu
Clicking on the small arrow beside the generator button will invoke the generator
drop down menu, from there it is possible to choose the output signal type to be
generated. The default signal at startup is @ 1031.25Hz sinusoid.
Refer to Chapter 7 Signal Generator for a detailed description of all the features
of the generator.

4.5.4 MICROPHONE CONTROL

% Switches Channel A 24V phantom power on and off. This supply is capable of
operating any balanced microphone and also to operate Audiomatica's
microphones MIC-01, MIC-02, MIC-03 or MIC-04.

8 Switches Channel B 24V phantom power on and off. This supply is capable of
operating any balanced microphone and also to operate Audiomatica's
microphones MIC-01, MIC-02, MIC-03 or MIC-04.

To enter the microphone sensitivity please refer to CLIO Options>Units
Conversion (chapter 5).
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4.5.5 HARDWARE CONTROLS SUBMENU

Within this submenu we learn all the keyboard shortcuts associated with the
controls described up to now.

ESC

© CLIO 12 - ELECTRICAL & ACOUSTICAL TESTS

= PlEEEOS O X-| MK
|l File ’
Analysis 4
" Kill Generator Esc
Window r ")) Generator Control Panel
) Help » Output Level -1dB /7
Recently Opened Files Output Level -0.1dB Shift+F7
Output Level +1dB F&
Celibretion Output Level +0.1dB Shift+F8
Exit Output Level Control Ctrl+F8
Mute CHA Ctrl+F7
Mute CHB Shift+ Ctrl+F7
'8 CHA In Qut Loop
B CHB In Out Locp
’E’ Input Autorange
- CH A Input Polarity
CH A Input Full Scale +10dE Fo
CH A Input Full Scale -10dB F10
L cHB Input Polarity
CH B Input Full Scale +10dB  Shift+F9
CH B Input Full Scale -10dB  Shift+F10
A-B Link Input Full Scale Control
{2 CHA Mic Power Supply Ctrl+P
{8 CH B Mic Power Supply Ctrl+Alt+P
=7 (QCBox & LPT Controls Shift+F4
B Turntables Controls Ctrl+F4
y Autoscale F&

Immediately kills the generator. Equivalent to releasing ¢

F7 Decreases the output level of 1dB. Equivalent to ™

SHIFT+F7

Decreases the output level of 0.1dB. Equivalent to SHIFT+ ¥

F8 Increases the output level of 1dB. Equivalent to

SHIFT+F8

Increases the output level of 0.1dB. Equivalent to SHIFT+

CTRL+F8

Opens the Generator Input Level dialog.

CTRL+F7

Mutes/Unmutes channel A.
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SHIFT+CTRL+F7
Mutes/Unmutes channel B.

F10

Increases channel A input acceptance of 10dBV. If the Link Button *® is pressed
then decreases also channel B input acceptance of 10dB.

SHIFT+F10

Increases channel B input acceptance of 10dBV. If the Link Button “® is pressed
then increases also channel B input acceptance of 10dB.

F9 Decreases channel A input acceptance of 10dBV. If the Link Button “* is pressed
then decreases also channel B input acceptance of 10dBV.

SHIFT+F9

Decreases channel B input acceptance of 10dBV. If the Link Button ¥ is pressed
then increases also channel B input acceptance of 10dBV.

CTRL+P
Swithces channel A microphone power supply on and off. Equivalent to 1

CTRL+ALT+P
Swithces channel B microphone power supply on and off. Equivalent to 18

SHIFT+F4
Enters the QCBox and LPT control panel. Equivalent to ==

CTRL+F4
Enters the Turntables Controls panel. Equivalent to =

F6 Enables/disables autoscale. Equivalent to &

4.5.6 SAMPLING FREQUENCY

48kHz
. | Indicates the current sampling frequency of the instrument. To change it

simply click on it and refer to CLIO Options>Hardware (chapter 5).
4.5.7 TEMPERATURE

39C
Indicates the current internal temperature of the instrument.
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4.6 QCBOX & PORTS CONTROLS

L3 Enters the QCBox & Ports Controls dialog box.

QCBox & Ports Controls * (QCBox & Ports Controls K
& QCBox ¥ Wodel 5 Ports 9 QCBox ¥ Model 5 &1 TTL Pots € Bi¢ *

® Input 1 Input & @ Input 1 Input &

O Input 2 Input 6 O Input 2 Input &

O lnput 3 Input 7 O Input 3 Input 7

O Input 4 Input 8 O Input 4 Input &

O Imp Internal O lImp | Sense O Imp Internal O Imp | Sense

TYPE Model & v TYPE Model & v

This control panel helps you when you are operating the CLIOQC Amplifier &
SwitchBox. You may choose the Amplifier & SwitchBox model and set its functions.
These controls are self-explanatory and are also covered in the unit's user's
manual; along this manual we will refer to it as the Amplifier & SwitchBox or simply
QCBox.

Depending on software version there are other tabs that allow direct controls over
different external hardware like parallel port bits.

4.6.1 DEDICATED CONTROL OF THE PARALLEL PORT

TTL bits from a standard LPT port can be used to control an external device like a
turntable.

You can set the proper PC parallel port (LPT):

QCBox & Ports Controls *
(9 QCBox ¥ Model 5 Ports
LPT Port MONE  ~
[JForce LPT1 /O Address (Hex) 0000
[JForce LPT2 I/O Address (Hex) 0000
[JForce LPT3 IO Address (Hex) 0000

Note: Parallel Port (LPT) legacy drivers are available only for 32-bit
Windows; they are not furnished with the CLIO software but are freely
available for download from Audiomatica.
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4.6.1 DEDICATED CONTROL OF THE QCBOX MODEL 5
With this dialog box it is possible to access to the QCBox 5 enhanced features.

It is possible to:

-Set the output current protection threshold in the range 0+10A

-Add a DC voltage (£20 V) on the amplifier output

-Set the input power supply (to operate a microphone) in the range 0+24V
-Measure the output current

-Measure the load connected to output

-Measure DC voltage at IN 3 and IN 4 (and refer it to displacement when a laser is
connected).

-Set output bits of the Digital IO port

-Read input bits of the Digital I0 port

-Read Pedal input bit

I t DC t volta
npu output voltage Activate DC output voltage

Read DC output voltage \
[ QCBox & LPT Controls \ @1
@hqeBox| ¥ Model 5 |517\TL | & LPT|
Zero DC output voltage E] 17V \ U @
Set input phantom supply — = 8.2V IN 3 DC: 0.02 mm Toggle reading V / mm
IMN4DC: 3.53mm

- Out Current: 0.22 A
Set output current limit ——— '~ 20A Out Load: 7.65 Ohm

T Start measuring

a&a00
(11 .
e Measure:
IN 3: DCV or mm
) IN 4: DCV or mm
Read TTL input bit ~ Set output TTL bit Out Current: A
Out load: Ohm

Read Pedal input
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4.7 CONTROLLING TURNTABLES

This control panel allows the control of one or two turntables. The control of two
turntables is available only with the QC software version.
Using two turntables it is possible to measure the loudspeaker response in three

dimensions, i.e. the software can send commands to the turntables to aim the
loudspeaker under test in a given direction.

Turntables Controls [i_E-J

Polar Azimuth
Turntable1 Turntable 2

KO | | PO4| | 0M| KO | PO 0D
[ ]180.0] B | | K |180.0f P

4 % ] %

| Link Turntable 1 | | Link Turntable 2 |
| B Autosave | | L Sync | | Options |
b i

140 Reset turntable position to angle 0 by clockwise rotation (degrees up)

OM Reset turntable position to angle 0 by counterclockwise rotation (degrees down)
g Set turntable reference angle (0 degrees)

M Goto angle by clockwise rotation (degrees up)

H Goto angle by counterclockwise rotation (degrees down)

ﬂ Step angle by clockwise rotation (degrees up), note that the step size is a
turntable setting that cannot be accessed from CLIO

9 Step angle by counterclockwise rotation (degrees down)

@ Stop the turntable rotation

| Link Turntable 1 | and | Link Turntable 2
4 CLIO BASICS
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positions to the measurements

- 1800

10.0

Display turntable current angle (top) and next angle (bottom), while the turntable
is rotating the bottom background is highlighted in red.

Aut [ i
B Autosave] o1 the Autosave Settings dialog

L Sync

Reset turntable angles according to Autosave Settings

Open the Turntables Option dialog

Start
b Sta Start an MLS Autosave measurement set

&l Stop

Halt an MLS Autosave measurement set

Continue
L Resume an MLS Autosave measurement set
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4.7.1 TURNTABLES OPTIONS DIALOG

With this dialog it is possible to choose which model of turntable to use for each
rotating axis (polar and azimuth). The software can take full control of the
Outline ET250-3D, the LinearX LT360, the FangBo FT360 turntables or the Four
Audio ELF robot. It supports also (limited to the polar rotation) a TTL pulse control
(using the Digital IO of the QCBox Model 5 or, if present, the Parallel Port of the PC)
which can be used to trigger the Outline ET/ST turntable or any other device. Using
the combo box it is possible to choose which turntable model to use and its
settings.

Outline ET250-3D
The Outline ET250-3D uses an Ethernet connection, please refer to the
manufacturer documentation to setup the device. In the option dialog it is
necessary to input the turntable IP and TCP/IP port.

Turntables Settings |£|

Turntablel Turntable?

Outline ET250 ~| |Outline ET250 ~|

192.168.0.70 192.166.0.71
Port GEG6 Port GB6?7

Delay 0 Delay 0

)8 Cancel

Note: In order to work properly the basert.dll file must be present into the
CLIO installation directory.

LinearX LT360
The LinearX LT360 turntable uses an USB or COM connection, please refer to the
manufacturer documentation to setup the device. In the option dialog it is
needed to input the communication port to be used.

Tumntables Settings |£|

Turntablel Turntable2

|LinearX LT360 ~| |LinearX LT360 |

|coMT +| [com2 -
19200 +| [19200 -
Delay 0 Delay 0

)8 Cancel

Some turntables settings, such as the rotation speed and the velocity profile
must be managed using the software supplied with the turntable. For correct
operations with CLIO software the “"Display Readout Polarity” setting of
the LT360 turntable must be set on “"Unipolar”.

Note: In order to work properly the 1t360lib.dll file must be present into the
CLIO installation directory.
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FangBo FT360
The FangBo FT360 turntable uses a COM connection, please refer to the
manufacturer documentation to setup the device. In the option dialog it is
needed to input the communication port to be used.

Turntables Settings x

Turntablel Turntable2
FBO FT360 ~ | Manual w
COM3 w

Delay El

DK Cahcel

Four Audio ELF
The Four Audio robot uses a COM connection, please refer to the manufacturer
documentation to setup the device. In the option dialog it is needed to input the
communication port to be used. To work properly both turntable settings must
be manually set to the same COM port that controls the robot.

Turntables Settings &J

Turntablel Turntable2

|FourAudio ELF | |FourAudio ELF |

|coMT +| [com1 -
19200 +| [19200 -
Delay 0 Delay 0

)8 Cancel

ke

The delay parameter (in milliseconds) puts the software in a wait state after the
completion of the turntable rotation, this can be useful in a non anechoic space
to let the energy in the room to decay between measurements.
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TTL pulse control (Outline ET/ST Turntable)
Selecting TTL pulse it is possible to control a turntable using a TTL signal. This
is valid only for the polar angle and with this selection it is not possible
to use two computer controlled turntables. In this case the second
turntable can be only selected as “Manual”.

Turntables Settings L= ]
Turntable1 Turntable2
TTLPulse  ~| |Manual -|
‘acBoxs -
Step 5.0
Speed 0.750
| ok | | Cancel |

The TTL pulse control uses the digital IO output port of the QCBox model 5 or, if
available, a Parallel Port (LPT) of the PC.

Note: Parallel Port (LPT) drivers are available only for 32-bit Windows.
In case of 64-bit Windows use a QCBox Model 5.

The information given next apply to the control of the Outline ET/ST Turntable;
they can be adapted to any other device.

Using a QCBox Model5: the control is achieved with Bit 5 of the QC Box digital
I/0 port, the turntable should be connected to the QCBox 5 output port by
means of a cable (DB25 female to DB9 female) connecting the following pins:

QCBox5 connector (DB25 male) ET/ST connector (DB9 male)
Pin 6 <-—-—------—-ommmmmm > Pin 2
Pin 14 <- - ————— > Pin 4

TTL TURNTABLE
CONTROL BIT

A |

INPUT BITS QUTPUT BITS

3 2

Ll TTTT T

13
25
12
24

1
23
10
22

QCBOX MODEL 5 DIGITAL 1O

Using a Parallel Port (LPT): the control is achieved with Bit 7 of the output
bits, as shown in figure. The turntable should be connected to the parallel port of
the computer by means of a cable (DB25 female to DB9 female) connecting the
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following pins:

PC connector (DB25 male) ET/ST connector (DB9 male)
Pin 9 <-—--------—--—mmmmm > Pin 2
Pin 22 <-————-—————————————————— > Pin 4

All other pins unconnected

— BITO

— BIT 1

BIT 2

BITZ

BIT 4

BITS

LLLlLLl

BIT&

OQUTLINE ET1/ST1
s BT7 — ™ controL

START €—

@OQOQOOOOOOOOOOOO?Oﬁ)o?o?q)\

The cable should be connected as in the following figure.

Connecting cable to QCBox Model 5 or LPT port

I |  —

1

3

LI | | | — | | | —

Fig.4.9 Outline ET/ST Turntable connections

Inside the Turntable Option panel it is possible to set its Step value (in degrees)
and Speed (in rotations per minute); the combination of these settings give the
software an indication about how much time to wait after the controlling pulse is
output.

Manual

For the azimuth angle only is it possible to choose the “Manual” turntable. This
means that the azimuth rotation of the loudspeaker under test must be managed
manually. Instead of automatically control the turntable, the software display a
pop-up message to the operator and wait for the completion of the manual rotation.

Please refer to chapter 12 for further information on polar measurement sets.

54 4 CLIO BASICSCLIO 12 QC - USER'S MANUAL



4.8 BASIC CONNECTIONS
4.8.1 CONNECTING THE CLIO BOX

In order to correctly interface CLIO with the outside world you should always keep
in mind the following electrical specifications:

MAXIMUM INPUT VOLTAGE: +40 dBV (283 V peak-to-peak)
MAXIMUM OUTPUT VOLTAGE: +18dBu (6.156Vrms) (sine)
INPUT IMPEDANCE: 128 kOhm

OUTPUT IMPEDANCE: 660 Ohm

AUDIOMATICA

The CLIO system is stereo and can simultaneously process two balanced analog I/0
channels which are named channel A and B.

INPUT CHANNELS

The CLIO Box input uses two XLR Combo female connectors. These particular
connectors accept also a 6.3mm standard jack.

Using a standard 6.3mm MONO jack is the easiest way to input unbalanced
signals to CLIO.

Two 6.3mm mono jacks are supplied in each CLIO system package.
OUTPUT CHANNELS

The CLIO Box output uses two XLR male connectors. In parallel you also find two
RCA plugs that are used to take the output signal unbalanced.

Please note that there it will always be a 6 dB difference between the CLIO
balanced and unbalanced outputs.

By default the Output Level display is referred to the balanced output, in this
case the unbalanced output level is 6 dB lower. In order to display the
unbalanced output level is necessary to select the proper option in the Output Level
display; in this case the balanced output is 6dB higher than the unbalanced one.

The output of channel B is usually driven in parallel with channel A output.

As generator controls suggest all internally generated signal are 'mono’, so they are
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played. The easiest way to have different output per channel is to play a stereo
.wav file with desired content in each channel.

INPUT-OUTPUT SCHEMATIC AND LOOPBACK

The following schematic illustrates the input-output structure of one channel:

CLIO fw-02

IN

20y +
3C

1@1/ '/J

______ — ’\\//\\/”
g 3

£ 300 QUT

AT

7%
¥ 00 \\f})

Channel In Out Loop @

I

To be noted the internal analog loopback that can be activated with the relative

buttons described earlier.

REAR PANEL CONNECTIONS

On the rear panel you also find an RCA connector for digital SPDIF output. SPDIF
output is a digital replica of analog output and constantly follows it. No controls are
available on this data stream.
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4.8.2 CONNECTING A MICROPHONE

For acoustical measurements, the microphone (optionally followed by a preamplifier
or power supply) requires to be connected to CLIO's input channel.

When using a MIC-01, MIC-02, MIC-03 or MIC-04 microphone it is possible to
connect it directly to CLIO's input; remember, in this case, to switch the phantom

voltage on by pressing the phantom button ©® It is good practice to wait a few
seconds before taking measurements as the microphone's output stabilizes.

If the measuring point is far from the PC, always lengthen the connection between
the preamplifier and CLIO. Make sure that you never use microphone cable that is
longer than the one that has been supplied.

In figure we see the typical test setup for performing acoustical measurements of a
loudspeaker. Please note that in this schematic diagram the output of the power
amplifier is connected to the loudspeaker with an inversion in the cables polarity;
this compensates the fact that microphones are usually phase inverting ; when
making polarity measurements always treat the measuring chain in this respect
considering that the CLIO hardware itself is NON-INVERTING and that all
calibrations are usually made under this assumption: any external device like
amplifiers, microphones, accelerometers, preamplifiers etc. has to be carefully
checked.

It is possible to achieve the same result, via software, simply clicking on the input
polarity button e in the hardware controls toolbar.

INPUT (A ORB)
OUTPUT (A CRB)
4 MCROPHONE
— ——
BLACK RED (
RED BLACK [[
POWER AMPLIFIER
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4.8.3 CONNECTING THE CLIOQC AMPLIFIER & SWITCHBOX

The CLIOQC Amplifier & SwitchBox is the natural companion of the FW-01 Audio
Interface to carry out your measurements.

There are two distinct mechanical assemblies that enhance the final result as:
-They create the best possible ground connection between cases.
-The assembly forms a single instrument and is more convenient to use

For fixed installations in standard 19” rack housings; perfect for Quality Control
production lines.

666.@

Compact, space saving solution; perfect for laboratory use.

,n
L

®

The figures below show the connections of a CLIOQC Amplifier & SwitchBox to
CLIO. Refer also to the unit's user's manual for details.
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The unit has its internal switcher set for response measurements.

INPUT A

INPUT B

CLIO OUTPUT A

OUTPUT B

LPT (Model 1, 2, <
3and4)

USB (Model 5)

CLIO QCBOX

| SENSE

BLACK

/o GAIN FROMCLIO

N | B
| |

INPUT 1 ——o\.

R B GAIN = 10 dB (Model 1, 2 & 3)
GAN = 20 dB (Model 4)

INPUT N o GAIN = 26 dB (Model 5)

These are the connection for impedance measurement in ISense Mode.

INPUT A

INPUT B

CLIO  aseura

OUTFUT B

LPT (Model 1, 2, <
3and4)

USB (Model 5 ‘

CLIO QCBOX

-l £

GAIN o | T

| SENSE

N | -
L o

NPUT 1 —— o T

NP2 B GAIN = 10 dB (Model 1, 2 & 3)
GAIN = 20 dB (Model 4)

INPUT N - GAIN = 26 dB (Model 5)
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5 SYSTEM OPERATIONS AND SETTINGS
5.1 INTRODUCTION

This chapter completes the introduction to CLIO started in Chapter 4.
Here you will find information about:
- Files extensions

- File operations and shortcuts

- Exporting data

- Exporting graphics

- Printing

- Software option

- Desktop control

- Calibration of CLIO

- Startup options

- Measurements settings

5.2 REGISTERED FILE EXTENSIONS

During its installation CLIO registers several file extensions which will let you easily
find a file done during your work. Browsing your hard disk you will then encounter

the icons that we are going to describe.

MIS| mLs&LogChirp data files.
Y
P MLS&LogChirp process files.

JU 2D Directivity & 3D Balloons data files.
¥
t Al Time Frequency data files.

P

iy Acoustical Parameters data files.
: tt FFT and RTA data files.

S| sinusoidal data files.

SPro| sinusoidal process files.
&

1] Multi-meter data files.
S T&S parameters data files.

Wow&Flutter data files.
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%E%\ Leq data files.

t Linearity&Distortion data files.

s

“&‘IFI Multitone definitions files.
asd| autosave definitions files.
5NAa| pesktop snapshot files.

sip | cLio setup files.

OLD CLIO Signal files; not used but supported.

OLD MLS&LogChirp impedance data files; not used but supported.
Il OLD Sinusoidal impedance data files; not used but supported.
WLl OLD Waterfall,Directivity & 3D data files; not used but supported.

WYl OLD Wavelet data files; not used but supported.

When you find a CLIO data file it is possible to invoke the program simply clicking
on the file itself; if CLIO is open it will load the file in the appropriate menu and
display it, if it is closed it will be launched then the file opened.

If you click on a Desktop snapshot file you will recall a saved work session
comprising open menu and data (see below).
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5.3 FILE SUBMENU

The figure shows the File Submenu and the shortcuts active.

€ CLIO 12 - ELECTRICAL & ACOUSTICAL TESTS

= vElEHEES 2| Oe X

[,!! File 4 2y open F3
Analysis r Import Shift+F3
‘ﬂ) Hardware Controls k JH Save As F2
Window k ﬂ:"-;ﬂ Autosave Options  Alt+F2
I@ Help r H Export Data Shift+F2
Recently Opened Files Eﬂ Export Graphics Curl-F2
ik
(.| Notes
Calibration
(=] Print Alt+P
Exit
E Options

@ Open Session

4 " Save Session As

% Clear Current Session

F3 Saves a measurement file relative to the active control panel.
F2 Loads a measurement file relative to the active control panel.

ALT+F2
Enters the Autosave Settings dialog box.

SHIFT+F2
Enters the ASCII exports dialog.

CTRL+F2
Enters the Graphics exports dialog.

ALT+P
Prints the active measurement.

5.3.1 LOADING AND SAVING FILES

¢/ Loads a CLIO measurement file or compatible file.
It is important to note that, usually, it is possible to load more than one data file.

You can select the desired file type from the 'Files of type' drop down inside the
Open dialog box.

When choosing 'All CLIO measurements files' then the Open dialog will display all
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available files otherwise they can be filtered by type like MLS Files (*.mls,
*.mlsi).

c Cpen [&J’
Lookin: M Desktop - 03 =
I Name Size Type Date modified =
ol ] a.met 4KB  Multi-Meter Meas...  08/01/2014 12:21 .
Recent Places Cuffia_ltalo.sin 64KE Sinusoidal Measur... 17/12/201314:39 ||
! @deltacompliancﬂil.sin TKB  Sinusoidal Measur...  16/01/2014 09:45
@ deltamass13g.sin TKB Sinusoidal Measur...  16/01/2014 03:44
Desktop Denon_DP.sin 64 KB  Sinusoidal Measur...  18/12/2013 09:39
T - freeair.sin TKB Sinusoidal Measur...  16/01/2014 03:44
K @Pioneer_Earphone_MJ.sin 64 KB Sinusoidal Measur...  17/12/2013 14:36
Audiomatico Stax_SR44.sin 64 KB  Sinusoidal Measur...  14/12/201310:02
@ Ultrasone_Proline2500.sin 64 KB Sinusoidal Measur...  18/12/2013 09:53
._k @ Ultrasone_Proline2500_CHL.mls 265KB  MLS Measuremen... 18/12/2013 09:53
Computer @ Ultrasone_Proline2500_CHR.mls 265 KB ML5 Measuremen...  18/12/2013 10:01
_ J Unihan File Folder 06,/01/2014 15:30
A Public
N.e?wﬁrk 1M Computer
1 3D Make File Folder 05/12/2013 17:50
%" Network | | | A
4 1 r
File name: -
Files of type: All CLIO measurement files Caneel
, VLS files (*.mls.” misi]
All CLIO measursmert filss

p——

A measurement file can be opened also simply dragging it onto CLIO Desktop
using the mouse.

~{#]

i Recalls the Save As Dialog to save current measurement data in a binary

64

measurement file relative to the active control panel. It is important to note that
the following menu save more than one data file type:

-MLS saves frequency response files (*.mls) or impulse response as wave files
(*.wav)

-FFT and Leq save measured binary files (*.fft or *.leq) and captured data wave
files (*.wav)
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5.3.2 AUTOSAVE SETTINGS

Hlnvokes the Autosave Settings dialog. It is possible to define the autosaving
rules that will be followed by the measurements capable of this feature (MLS and
Sinusoidal).

There are two different Autosave modes: 1D and 3D. 3D mode is available
only in QC version.

1D mode:
There are five settings which serve to define the 1D autosaved file name:
Path defines the folder where the file will be saved; it is possible to choose it

clicking on the browse for folder button --. In figure we see path defined as My
Documents\Audiomatica

Root File Name defines the part of the file name that will not change during
Autosave; in figure it is 'RogersHalfChirp'.

Start defines the initial humber appended to the root. This number will always
be multiplied by 100 to give space for two decimals management. Numbers are
appended with spaces. In figure start is -180; this will define the first autosaved
file name as 'My Documents\Audiomatica\RogersHalfChirp -18000'

Increment defines the increment to be given to the autosaved file names. In
the example of figure the second autosaved file will be named 'My
Documents\Audiomatica\RogersHalfChirp -17500' and so on

Total Number defines the number of autosaved files after which the process is
automatically ended

AutoSave Settings >
& |mnl | | Bin | Txt | 256 pts.
Path

_gh\administrator\D ocuments

F oot File Mame

1-D
Stark 1800
[nizrement 500
Total Hurmber
aF. Cancel
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3D mode (ONLY in QC version):

66

There are several settings which serve to define the autosaved file name:
Path defines the folder where the file will be saved; it is possible to choose it

clicking on the browse for folder button --. In figure we see path defined as My
Documents\Audiomatica

Root File Name defines the part of the file nhame that will not change during
autosave; in figure it is 'RogersHalfChirp'.

Polar Start defines the polar angle start

Polar Step defines the polar angle step

Polar Stop defines the polar angle stop

Azimuth Start defines the azimuth angle start

Azimuth Step defines the azimuth angle step

Azimuth Stop defines the azimuth angle stop

Please refer to chapter 12 for the definition of polar and azimuth angles.

[ AutoSave Settings lihj )
v - B[ =
Path

. torsDocuments\Audiomatica

R oot File M ame
FiogersHalfChirp

1D 3D
Polar Azimuth
0.0 Start 0.0
5.0 Step 5.0
180.0 Stop a55.0
Smart Scan [Th]

0k, Cancel

It is possible to save in the standard binary file format (Bin) and/or to export in
text format (Txt). The MLS Export Size button:

256 pts. 64 pts.
125 pts.
® 256 pts.
512 pts.
1024 pts.

2048 pts,
—e

selects the number of export data points for MLS ASCII files.

It is possible to save % and load 4 these definitions in an Autosave Definition
file (*.asd).
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5.3.3 EXPORTING ASCII DATA

e CLIO is able to export the currently active measurement in an ASCII file (*.txt).

Export ASCI Data %
Display Frequency Data  ~ Ta File
- ¥ To Clipboard

[]Also XLS
[ ITAB delimited Cancel

Upon performing this choice you will be prompted by the Export dialog.

To File
Depending on the measurement menu you are working with, it will be possible
to choose different data to export to a file on disk.

To Clipboard
ASCII data will be copied to Windows Clipboard.

Also XLS
In parallel to the ASCII file it is created also an Excel spreadsheet with the same

filename and .xls extension.

TAB Delimited
Uses TAB instead of spaces as delimiter.

5.3.4 EXPORTING GRAPHICS

=) CLIO is able to create enhanced metafiles (*.emf), bitmaps (*.bmp),
portable network graphics (*.png), JPEG (*.jpg) or GIF (*.gif) of the
currently active measurement. The graph is drawn using the same colors and
settings of printouts; you can define them with the CLIO Options>Graphics
dialog.

[ Export Graphic &y
GIF <] | ToFie
1024 x 768 *| [ To Ciipboard
[ Black&White —_—
i | Cancel
[] Optimal Settings

Black&White
Check the box to discard color information.

Optimal Settings
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CLIO chooses graphics settings for you overriding system defined ones.

To Clipboard
Graph will be copied to Windows Clipboard.

5.3.5 NOTES ABOUT MEASUREMENT

i

L2 Enters the Notes dialog where it is possible to input comments to be saved with
the actual measurement and inspect other measurement information. Check
boxes enable printing notes and exporting notes to graphics files.

b |
Motes about measurement (check boxes to print): Lé_?ﬂj

¥  Measure : LogChirp - Frequency Response

¥  Date 1 15-01-2014 @ Time:17.11.45
¥ File Name:

¥ Company : Audiomatica Sl

¥  Seftings : CHA dBV Unsmoothed 48kHz 16K
Rectangular Start 0.00ms Stop 341.31ms
FreglO 2.93Hz Length 341.31ms

¥  MNotes:

| 8 Cancel

5.3.6 PRINTING

‘= Prints the current active measurement. The definition of printing colors and font
settings is done with the CLIO Options>Graphics dialog.
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5.4 CLIO OPTIONS

T4 Opens the CLIO
5.4.1 GENERAL

Options dialog box

Opening this tab you can define the following:
- The Company Name which will appear in all printouts.
- Some On Exit settings regarding when the program has to prompt and if you

want to autosave a

nd reload the measurement session.

- The Signal Generator and Multimeter settings.

- The location of th

e Hardware Controls Toolbar.

- The behavior of the graph on file load.
- The style and behavior of the graphic curve display.

CLIO Options >

General |nits Conversion Graphics Hardware QC Operators&Passwords

Company Name

|Audi0matica Srl

On Exit

Prompt before ending program or measurement session
] Ask to save unsaved measurement data
[] Save measurement session

Signal Generatar

[1Prompt before playing a signal
] Alt-G starts playing a signal

Multi-Meter
Prompt before setting ref voltage or cal pressure

Hardware Controls
Stay On The Bottom

On File Load
[IMaintain User Scales on Graph
Graph Display
[CIMain Curve Stay On The Top
1-2-5 Log Frequency Scale (X-Axis)
10 Divisions Y-Scale

Cancel
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5.4.2 UNITS CONVERSION

Opening this tab you can define the following:
- Enter the microphone sensitivity and the microphone response correction.
- Enter all other transducers sensitivity and reference levels.

CLIO Optiens X

General Units Conversion Graphics Hardware QC Operators&Passwords

Pressure (Microphone)

Sensitivity [mV/Pa] cHal30.00 | chB|30.00 |
Frequency Correction CHA ] CHB []
Carrection File MICA MICB
Displacement (Laser)

Sensitivity [V/m] cHA[25000 |  cHB|[25000 |
Velocity (Laser)

Sensitivity [V/(m/s)] cHA[1000 | cHB[1000 |
Acceleration

Sensitiity [mv/(m/s?)]  CHA[10.00 | cHB[10.00 |
Current (QCBox)

I1Sense [W/A] 0.100
Power

Reference Impedance [Ohm] 8.00
dBRel Reference

Reference Level [V] 1.000

dBPa Reference

dBRel Reference Level

CLIO Qutput Level

CLIO OQutput Level Unbalanced
QCBox Output Level

OO @O

Amplifier Gain [dB]

Cancel

MICROPHONE SENSITIVITY

When taking acoustical measurements, the readings and the scales will be in
Pascals (Pa, dBSPL, dBPa or dBPa/V). In this case, the software will assume that
you are measuring a pressure quantity and it therefore needs to know a conversion
factor that defines the voltage produced by the microphone when it is measuring a
certain pressure. This conversion factor is usually the sensitivity of the microphone
(as found in the microphone’s calibration chart) or the sensitivity of the microphone
+ preamplifier chain of equipment.

If you are working with the CLIO system standard accessories there are two
possible cases:

a) you may use a microphone MIC-01, MIC-02, MIC-03 or MIC-04 directly
connected to FW-01; as the FW-01 powers the microphone with 24V while
sensitivity is factory checked at 8.2V it is necessary to input the given sensitivity
of the microphone (in mV/Pa) increased of 3.3dB i.e. multiplited by 1.465.

b) you are using the PRE-01 preamplifier, it is necessary to know its internal gain;
if it is 0dB then input the microphone sensitivity, if it is +20dB then input the
microphone sensitivity multiplied by 10.

NOTE: It is necessary to input two separate sensitivities, one for channel A and one
for channel B.
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Please also refer to chapter 8 for a description of the controls useful to
capture the sensitivity of the microphonic chain when using an acoustic
calibrator capable of producing a known pressure.

CORRECTING THE MICROPHONE RESPONSE

By checking the Frequency Correction check boxes the software will correct the
measured curve according to the data stored in two text files, which you have to
provide.

Note: microphone correction will affect the measured curve only if dBSPL
(or dBPa or dBPa/V) is selected as Y Scale unit.

The microphone correction files, if present, must be placed inside the
installation folder (usually c:\program files\audiomatica\clio12\).

These text files containing the correction data must have .CAL extension; the
default names are “MICA.CAL" (for input channel A) and “MICB.CAL" (for input
channel B) but you may use any.

To instruct CLIO which file to use you may load from disk clicking on the file name:

nits Conversion Graphics Hardware QC Opi

e (Microphone)

ity [mV/Pa] CHA [30.00 CHB |
ncy Correction CHA [] CHEB |
ion File MICA

ament (Laser) ol

vity [V/m] CHA MHB |

You have to load separately one correcting file per each channel you want to
correct.

GUIDELINES TO REALIZE .CAL FILES
Note: The maximum number of correcting points allowed is 100.

The example below shows a sample text file created to store the microphone
frequency response:

B Phase
0

Freg d

1000 0

4000 0.25
8000 0.33
10000 0.5
15000 1.75
20000 2.5

O O O O o

USING CALIBRATION FILES FURNISHED BY AUDIOMATICA

If your microphone came with frequency calibration data supplied by Audiomatica
(see chapter 2) you can find the correction file inside the furnished disk.
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The file is stored with the name serialnumber.cal; for example in the disk given
with the microphone with serial 5213431204 you will find the “5213431204.CAL"
file.

To use it (for channel A) you must:

1) Copy it inside the CLIO installation folder
2) Load it as described above

3) Check the Frequency Correction box

Looking at the calibration chart you will also find sensitivity data:

r Free-field Microphone 5.0, 1
llj Type Mic 02
AUTHONATICN Calibration Chart dB
Serial No: 5213431204 0.0 N
Sensitivity: -36.7 dB re 1ViPa
) 14.69 mViPa
Valid at: 50
Temperature: 23 c -
Ambient Static Pressure: 101.4 kPa
Relative Umidity: 43 %
Frequency: 1000 Hz
Polarizafion Conditions: 8256 V-KOhm -10.0
Reference Instruments:
MANUF. MODEL  SERIALNO CALIB. DATE
AGILENT 344104 MY45000650 20-11-2013
LARSON DAVIS 812 416 03-04-2013 -15.0
GRAS 4248 31716 03-04-2013
GRAS. 40BE 55475 04-04-2013
Date: 10-Apr-14 Cerificate NO: 1471 Signature : M. -20.0
|_ 20.0 100 1k 10k Hz 20k
|

In the picture below it is displayed the final situation provided you have also set the
proper mic sensitivity (in this example 14.69*1.465=21.52 mV/Pa).

General Units Conversion  Graphics Hardware QC Operators&Passwords

Pressure (Microphone)

Sensitivity [mV/Pa] CHA CHB

Frequency Correction CHA CHB [
Caorrection File 5213431204 MICB

Niznlarament (1 azer

DISPLACEMENT, VELOCITY, ACCELERATION, CURRENT, POWER
Set the sensitivity for each of these units where used in the program.
dBREL REFERENCE

Sets the voltage reference for the unit dBRel.

dBPa/V REFERENCE

When measuring with dBPa/V it is possible to use as reference level:

- the dBRel reference voltage

- CLIO output level (balanced)

- CLIO output level (unbalanced)

- QCBox Output

- Output of any amplifier of a given gain in dB connected to the balanced output
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5.4.3 GRAPHICS

Opening this tab you can define the following:

- Screen Colors

- Print (and graphics export) colors

- Screen line width

- Print (and graphics export) line width and font size.

CLIO Optiens *
General Units Conversion Graphice  Hardware QC Operators&Passwords
Colors
Background Ml Large Text
Grid I Bar graph |
Main Curve A QC Curve C Color Scheme
Main Curve B QC Curve D
Cwerlay 1 Bl QcCunveE
Overlay 2 QC Curve F 2EEL e
Overlay 3 QC upper limit A
Overlay 4 QC lower limit A
Cwerlay 5 QC upper limit B I
Cwerlay 6 Hl QC lower limit B
Overlay 7 B QC upper limit C
Overlay 8 QC lower limit C
Overlay 9 QC upper limit D
Aux Curve 1 Bl QC lower limit D
Aux Curve 2 QC upper limit E
Aux Curve 3 Bl QcC lower limit E
Aux Curve 4 QC upper limit F Default
Aux Curve 5 QC lower limit F
Aux Curve 6 QC bad |
Marker A QC bad text .
Marker B QC good
Text QC good text L]
Lines
Screen Lines Width [Pixel] 1 -
Print & Export Graphics Lines Width [Pixel] 2 ~
Font
Print & Export Graphics Font Size 12 ~

Apart from the Default color scheme, which is not changeable, it is possible to load
and customize up to 6 different color schemes: Classic (for old CLIO users), Userl,
User2, User3, User4 and Printing. The Printing color scheme, as the name implies,
will affect your printouts (and exported graphic files) and, if selected, will let you
preview how they appear on your screen.

Default button
When defining a color scheme you may press the Default button which will load the
Default scheme for your reference. If you are modifying the printing color scheme it

will load the default printing colors.
5.4.4 HARDWARE

Within this tab you can select the sampling frequency of the FW-01 unit. It is
possible to choose either 48kHz, 96kHz or 192kHz.
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5.5 DESKTOP MANAGEMENT

Desktop management is a powerful feature that lets you save your work at a
certain point and reload exactly as it was.

It is possible to do this automatically when exiting CLIO; at successive startup the
program will automatically reload from where you left; to do this activate the Save
measurement session from CLIO Options>General.

' Load a previously saved measurement session (*.sna files).

¢ Takes a snapshot of current measurement session and saves it to disk (*.sna
files).

X 1f pressed clears current measurement desktop i.e. closes and resets all
measurement menu. It is also possible to clear one single measurement
selectively opening and choosing from the associated drop down menu.
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5.6 STARTUP OPTIONS AND GLOBAL SETTINGS

You can start CLIO directly clicking on the CLIO.exe executable that is saved in the
installation directory (usually C:\Program Files\Audiomatica\CLIO12 or
C:\Program Files (x86)\Audiomatica\CLIO12); you may also access CLIO
either from Start Menu>Programs>CLIO12 or creating a shortcut on your
Desktop.

A second way to run CLIO is to click on a registered file; in this way you will not
only run the program but also load the file into the appropriate measurement
menu.

CLIO creates a temporary folder named Temp for several uses. This folder is
located under the Common Application Data folder that has the following path
(Windows XP):
C:\DocumentsAndSettings\AllUsers\ApplicationData\Audiomatica\CLIO12
or (Windows Vista, 7, 8 and 10):

C:\ProgramData\Audiomatica\CLIO12

CLIO relies, during startup, on a configuration file named CLIOXP.stp which
resides in the temporary folder. This file is written each time the program ends and
saves several settings that will be reloaded and reconfigure your system.

Among them we find (see chapters 4 and 5):
- program Options
generator output level
input sensitivity
phantom power supply state
autorange state
microphone settings
CLIOQC Amplifier & SwitchBox
color scheme and other setup settings
main window state
- global reference level
- autoscale state
Note: It is possible to return the system to its initial default state (after
installation) by deleting the CLIOXP.stp file.

5.6.1 SAVING MEASUREMENT SETTINGS

Measurements settings can be saved from within the various measurement menu;
to do this simply check the Save Settings box in the Settings dialog of each menu;
refer to specific menu chapters for details on settings.

H Save Settings l oK H Default || Cancel | H

Settings are saved in the mls.stp (MLS&LogChirp), sin.stp (Sinusoidal), fft.stp
(FFT), d3d.stp (Directivity), tfa.stp (Time Frequency), acp.stp (Acoustical
Parameters) , lin.stp (Linearity&Distortion) , leq.stp (Leq) files inside the
temporary folder. Upon finding one of these files at startup, CLIO will reset the
corresponding menu to the saved settings.
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6 COMMON MEASUREMENT INTERFACE
6.1 INTRODUCTION

This chapter deals with the graphical user interface which is used to display and
manage the measured curves within all CLIO frequency measurement menus. In
particular this Common Measurement Interface (CMI) is used by the FFT, MLS and
Sinusoidal menu. The understanding of CMI behavior and capabilities is very
important to use CLIO at its best.

6.2 UNDERSTANDING THE DISPLAY IN FRONT OF YOU

Fig.6.1 explains the main objects found in a frequency response measurement
display.

Y Scale Main Curve A Overlays 1.9 Curve A marker ©Overday marker B
Zoom / Selected -
- v 3$ I 9 M OORCGMACECEBEIFRCOBC B [EB
100 Mair
- chirve A Mafker B /—\/_\
[ P
00 L -\\h’*ﬁ{/’::/ Q\/fﬁ:‘\* . \/ﬁh"‘\._:}
1 et
Pratd \V'\, - \ \\_// T"\\,
P gl AN |
J— ’;f ™ Dverlay 3
Right // V_\_\ Selected
¥ Scale = | ¥
(Active) L Markef A ‘-\ [\
700
Y [ UATH
e
600 /\\/
Dverlay 6
00 Ffrequency scale (Pisplayed)

20 a0 100 200 500 1k 2k Hz 5k 10k 20k
A 2456195 Hz Ay 92,7385 dBSPL B 16259.2350Hz By 30.0362 dBSPL D 13836150 Hz Dy 26423 dBSPL

Markers readings {(A=Curve A, B=0Overlay3)

Figure 6.1

Inside the graph you find the main curve A which reflects an executed (or loaded
from disk) measurement; up to nine overlays curves which are stored by the user
and can be controlled interactively, the two markers which are activated by clicking
on the respective buttons.

Above the graph itself we find several buttons and checkboxes which divide into
three main categories: Y scales controls, main curve, zoom and overlays
management.

Each overlay can be displayed, hidden or selected with the relative
checkbox.

Marker A reads curve A; marker B has a twofold operation: it reads the
selected overlay, if present, otherwise reads again curve A.

Aside and below the graph we find the Y Scales, the Frequency (or Time) Scale and
Marker Indicators. The Y scale is of the same color of the main curve selected.

The objects described may, from case to case, not all be present at the same time,
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as in the case of Time Data display in the FFT menu. The frequency (or time) scale
may be logarithmic or linear. A particular representation is the MLS time domain
which will be discussed later in 6.6.

It is possible to have two graphs in the same control panel (see FFT). In this case
one is referred as active after you have clicked on it.

To change the colors of the screen, main curve and overlays refer to section 5.4.

6.2.1 STEREO MEASUREMENTS DISPLAY

Fig.6.2

shows the differences that are present when a stereo measurement is

taken or loaded from disk.

Y Scale Main Curves A & B Overlays 1..9 Curve A marker Curve B marker

Zoom

-3 86 MHAODORODBBOAOEOEBODOBOBCO0 BB
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dB5PL e
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| -\_/"'" ™
11040 i ! ’/—\_.. 1600
T
I
|~
a0.0 L] 1200
Right Lot
Y Scale S
(Curve A f \ (Curve
heved 2 / SD'Uinacti\lre)
Main
50.0 / Curve B 410
i N \ B
£ \...‘___ 1] —_———
30.0 Frequency scale 00

20 50 100 200 500 1k % Hz 5k, 10k, 20k
\ A 11220210 Hz Ay 1163600 dBEPL Bx 65.3783 Hz By 153.9313 Ohm
Markers readings { A=CurveA, B=CurveB)

Figure 6.2

Now you find two main curves A and B with two appropriate checkboxes to
control them; you may display, hide or select each of the main curves. By selecting
a main curve the relative Y scale is activated and scale controls operate on it.

If no overlay is present and selected marker B reads the main curve B, otherwise it
reads the selected overlay.
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6.2.2 COLLAPSING MARKERS

If you hold the SHIFT key pressed while moving the markers with the mouse you
will obtain that the two markers collapse into a single one reading the same
frequency point.

dBSPL
| [
: | L
1100 . =
ﬂ -_/—
[T
L] H
L1 :
0.0 ;
Marker Aland B
I ' \ together
00 / ‘)‘ ’SHIFT pressed)
500 : < ]\
00 |

20 50 100 200 || 500 1k
‘ A BRITHIHz Ay 101.5302 dBSPL B B5.3783 Hz By 153.9313 Ohm

6.2.3 DIRECT Y SCALES INPUT

80.0

0.0

60.0

e

20

It is possible to direct input of the Y scales values; to activate the input
boxes simply click on the scale extremes.
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6.3 BUTTONS AND CHECKBOXES

b

Moves (shifts) the selected curve upward.
Moves (shifts) the selected curve downward.

Expands (magnifies) the selected curve; it also changes the Y scale respectively.

pd O 4

Compresses (reduces) the selected curve; it also changes the Y scale
respectively.

.\ Zooms the curve in; it is possible to execute multiple zoom in actions.

e\ Zooms out the curve completely i.e. returns to the default initial zoom state.

EISwitches the main curve A on and off. In case of stereo measurements displays,
hides or selects the main curve A.

EIIf present, for stereo measurements, displays, hides or selects the main curve B
|I| Stores the main curve selected into overlay 1. It also displays overlay 1.
Stores the main curve selected into overlay 2. It also displays overlay 2.
Stores the main curve selected into overlay 3. It also displays overlay 3.
@ Stores the main curve selected into overlay 4. It also displays overlay 4.
E‘ Stores the main curve selected into overlay 5. It also displays overlay 5.
|E Stores the main curve selected into overlay 6. It also displays overlay 6.
Stores the main curve selected into overlay 7. It also displays overlay 7.
Stores the main curve selected into overlay 8. It also displays overlay 8.

E Stores the main curve selected into overlay 9. It also displays overlay 9.

EI Displays, hides or selects the respective overlay. It also shows its color.
@ Enables marker A.

Enables marker B.

80 6 COMMON MEASUREMENT INTERFACECLIO 12 QC - USER'S MANUAL



6.4 HOW TO ZOOM

1) Click on the Zoom+ button.

2) Position the mouse and PRESS the left mouse button at the beginning of your
selection and keep the mouse button pressed. Don't just click otherwise you get
a warning message!

3) With the mouse button pressed move the mouse until the second selection point.
4) Only now release the left mouse button.
Be careful: you must have the button pressed from point 2) to point 4)!

It is possible to zoom by direct input of the frequency extremes of the
scale; to activate the input boxes simply click on the scale extremes.

20 50 100 200 500 1k 2k Hz k. 10k 20000 .
6.5 SHORTCUTS AND MOUSE ACTIONS
The following keystrokes and mouse actions are active:

up arrow
equivalent to 4 on the active graph

Shift+up arrow
Y
equivalent to ¥ on the active graph

down arrow
equivalent to T on the active graph

Shift+down arrow
v
equivalent to 4 on the active graph

mouse click
activates the graph; useful when more than one graph is present (see FFT)

mouse left down
activates the marker

mouse left drag
moves the marker

mouse wheel up

equivalent to “*

mouse wheel down
equivalentto ¥
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6.6 THE MLS TIME DOMAIN DISPLAY

When entering the MLS&LOG CHIRP (but also Waterfall or Acoustical Parameters)
time domain you will find a different display (Fig. 6.2).

A4 v $I 86 w4+ OO @ABE
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0,00 bt | LAt

e [
W N S W NS SN SN NN W
i —.,., L
Bl - -— i
0100

0.0858 21 41 E1 .0 10 12 14 16 ms 18 20

Figure 6.2

In this case there is only one overlay. It is also possible to select a portion of the
main curve by means of three particular buttons. The selected portion of the main
curve is identified by a start and stop point and is drawn in a different color from
the unselected portion.

# Defines the start point of the selection. Before clicking with the button
activate Marker A and position cursor to the desired point.

+ Defines the stop point of the selection. Before clicking with the button
activate Marker A and position cursor to the desired point.

- Returns the curve to a completely unselected state.
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7 SIGNAL GENERATOR
7.1 INTRODUCTION

This chapter deals with the programmable signal generator of CLIO. Each paragraph
explains a type of signal, its settings and gives a time frequency analysis obtained
with the FFT narrowband analyzer (see chapter 9).

Refer also to chapter 4 for all hardware and software controls associated with the
signal generator.

Clicking on the generator button drop down you access the signal generator menu.

3 CACLIO1100\signal\easerachirplfk.way
2 CACLIO1100Nsignal\Hywel Maggs.wav
1 CACLIO1100Nsignal\Eli.wav

0 CACLIO1100Nsignalh Chirp2048.51G
Save Current Signal

File

All ’
Pink 3
Chirp

:
Ml 4 8K
White 16K
Pulse 32K
CEA Burst G4K
Multitone 128K
TwoSin 256K
Sin 512K

Generator Control Panel

- ¢ E]| {4 18| @ @ |48kHz

7.2 SINUSOID

It is possible to generate sinusoids of given frequency. Select the Sin choice in the
generator menu.

Generator Input Form |£|

Freguency [Hz]  1031.25
Time On [ms] 0.o0
Time Off [ms] 0.00

FFT Bin Round
[] Hanning

[ ok | | Cancel

The sinusoid can be continuous; leave the two inputs Time On and Time Off at
zero.
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Or it can be bursted; input the desired values in the Time On and Time Off inputs.

Select FFT Bin Round if you desire that the frequency is approximated to the

nearest FFT bin (with respect to the actual FFT size setting).

The time envelope of the burst can also be shaped with an Hanning tapering

window (see also later CEA Burst).

The following figure shows a 1031.25Hz continuous sinusoid.

o] s
A \ \ N ANE
NN N NN
IRV / / SN
L TR LI o
I HHARAN HATHRITARIE UL
S L .

CHA dBY 48kHz 32768 146Hz IntTrig Hanning Unsmoothed
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7.3 TWO SINUSOIDS

It is possible to generate two sinusoids of given frequencies and amplitudes. Select
the TwoSin choice in the generator menu.

[ Generator Input Form |£|1
Freg 1 [Hz] 1031.25
Freq 2 [Hz] 208250
Lewvel 1 [%] 50,00

Leweal 2 [34] 50,00

[ Ok ] l Cancel

The following figure shows a signal consisting of a 1031.25Hz and 2062.5Hz of
same amplitude (50% each).

Audiomatica St FFT 30-03-2005 16.59.01
00 cLio 31000
dBv | 1%
200 1500
a00f 100
600 1-500
800} 1-100.0
100018 i " l 1 | * 11500
20 100 1K 10k Hz 20k
200 200

CLIO |

A A Y VA A
N NN AW T AN

S AVARSAVARLVARS VAR VA »

200k 1.2.00
0.00 050 1.00 15 20 25 30 35 40 ms 45 50
CHA dBY 48kHz 32768 146Hz IntTrig Hanning Unsmoothed
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7.4 CEA BURST

It is possible to generate a particular burst signal useful for conducting the power
test described in CEA-2010 norm.

Generator Input Form — -

Freguency [Hz] G300

Mum Cycles .50

Rep Time [ms] 100000

| FFT Bin Round

| Harning

Ok l | Cancel

It is possible to define the number of cycles of the sinusoids and the repetition time
of the burst. Note that Cycles resolution is up to half sinusoid (6.5 in the example).
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=
2
=
Q)

dBv
200F

G
soof LI

(=)
[am]
(s
-
——
=
Lreedverebveerdbeverbeerr e erderrrirer bl

200 500 100 200 500 1k 2k Hz Sk 10k

]
(]
e

S/ AW A
AR,

WA

-2.00E
0 200 400 60.0 aon 100 120 140 160 ms 180

CHA dBY 48kHz 32768 146Hz InfTrig Rectangular Unsmoothed

]
]
(]

86 7 SIGNAL GENERATORCLIO 12 QC - USER'S MANUAL



7.5 MULTITONES

It is possible to generate multitones (mutiple sinusoids signals).
Multitone choice in the generator menu.

-
Multitone Generator |A|
¢ BE| = ~ ] e

J| 20 Hz 0.0 dB

J| 25 Hz 0.0 dB

J|  31.5Hz 0.0 dB

V| 40H=z 0.0 dB

J| BOHz 0.0 dB

V| B3Hz 0.0 dB

J| BOH=z 0.0 dB

V| 100 Hz 0.0 dB

| 125Hz 0.0 dB

V| 160 Hz 0.0 dB

J| 200 Hz 0.0 dB

V| 250 Hz 0.0 dB

V| 315Hz 0.0 dB

V| 400 Hz 0.0 dB

V| 500Hz 0.0 dB

V| B30Hz 0.0 dB

V| 800Hz 0.0 dB

Y| 1000 Hz 00de @

V| 1250 Hz 0.0 dB

V| 1600 Hz 0.0 dB

V| 2000 Hz 0.0 dB

V| 2500 Hz 0.0 dB

V| 3150 Hz 0.0 dB

V| 4000 Hz 0.0 dB

V| 5000 Hz 0.0 dB

V| 6300 Hz 0.0 dB

V| 8000 Hz 0.0 dB

V| 10000 Hz 0.0 dB

V| 12500 Hz 0.0 dB

V| 16000 Hz 0.0 dB

V| 20000 Hz 0.0 dB

v | 1000 v 00 4 os
Filename:
Eq/Shape File:

Select the

The following figure shows a multitone signal consisting of 31 sinusoids each with
frequency corresponding to the center frequencies of the standard 1/3rd of octave
bands from 20Hz to 20kHz and same amplitude.

FFT 30.03-2005 17.06.28
00 cLior] 1000
dBv E {%
200 1500
400 0.0
600 1-50.0
-80.0F 1-100.0
Aon.ok 4 1500
2 100 1k 10k Hr 20k
200¢ cLio 2%
Vi ]
120F 120
040 040
040 [ 040
-120f 120
200k 1,700
0.00 80 100 120 180 200
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7.6 WHITE NOISE

It is possible to generate a white noise. Select the White choice in the generator
menu.

The following figure shows the white noise signal.

Audiomatica St FFT 30-03-2005 17.11.23
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7.7 MLS

It is possible to generate MLS (maximum length sequences) of given length. Select
the MLS choice in the generator menu.

These sighals are the same used in the MLS analysis menu and should be used to
test them.

The following figure shows a MLS signal of 32k length.
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7.8 CHIRPS

It is possible to generate Chirps (sinusoids with frequency continuously variable
with time between two extremes) in two different ways.

You may generate full spectrum Logarithmic Chirps of given length selecting the
LogChirp choice in the generator menu.

These signals are the same used in the LogChirp analysis menu and should be used
to test them.

You may instead define Chirps of given length, frequency extremes and kind (linear
or logarithmic) selecting the Chirp choice in the generator menu.

Generator Input Form Iil

StatFreq[Hz] 20000
Stop Freq[Hz]  20000.00
Chirp Size |1Bk v|

Chira Type  [Logarithimic -

Ok l | Cancel |

The following figure shows a 20Hz to 20 kHz Log Chirp.
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The following figure shows a 20Hz to 20 kHz Lin Chirp.
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7.9 PINK NOISE

It is possible to generate Pink noises of given length. Select the Pink choice in the
generator menu.

The following figure shows a Pink Noise signal of 32k length measured with the FFT
narrowband analyzer.

Audiormatica St FFT 30-03-2005 17.17.11
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Pink noise signals are used normally to execute Octave bands analysis with the RTA
menu due to the flat reponse they produce when analyzed with fraction of octave
filters.
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The following figure shows the

RTA analyzer.
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7.10 ALL TONES

It is possible to generate All Tones signals of given length; an All tones contains a
sum of sinusoids of frequencies corresponding to each frequency bin with respect to
their length and sampling frequency. Select the All choice in the generator menu.

The following figure shows an All Tones signal of 32k length measured with the FFT
narrowband analyzer.
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All Tones signals are used with the FFT narrowband analyzer due to the flat reponse
they produce.
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For comparison with Pink noises the following figure shows the same All Tones
signal of above measured with the RTA analyzer.
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7.11 SIGNAL FILES

As a last possibility it is possible to play signal files saved on disk. Standard ‘.wav’
Windows Wave files are supported (‘.sig’ CLIO Signal files are supported for
compatibility with older versions of the software).

Choose File within the generator menu. The default extension lets you select a CLIO
signal file.

c Cpen lﬁr
Lookin: || signal - @ 5 S Y
= MName ‘ Artists Album 2 Genre »
';} ¢ | TkZkway || ceal00.wav & | PINK1024 WAV
Recent Places |3 1k2kinv.wav Chirp768.51G | PINK2048.WAY
|#|1kZkinvaud.wav Chirp2048.51G & PINK4036. WAV
- || 1kHzMenoG0dB.wav |4 easerachirplBkway | | PINKB192. WAV
deshop |4 1kHzMeno80dB.wav |4 easerachirplBklin.way || PINK16384. WAV
|4 1kHzMenol00dB.wav |4 | easerachirplékweight.wav | 3| PINK32768. WAV
'-r“: || Al258. WAV || Eliwav 4| PINKB5536. WAV
L || ANS12. WAV |# | Elistereo.wav & PINK131072. WAV
Audiomatico | )] AlIL024.WAV || Elistereabp.wayv & PINK262144 WAV
Lo AlIZD4E. WAV || Hywel Maggs.wav
E&-‘ || Al4096. WAV | |IEC16384-311 WAV
c 9] AlIB19Z. WAV || IMPULSE(NEGATIVE) wav
omputer
|4 All6384.WAY |4 IMPULSE(POSITIVE).wav
" || AlI32768. WAV || TterIECA5536-353. WAV
= || AlIB5536.WAY 4| legchirp32lewav
Network || AlIL31072.WAY || PINK256. WAV
|| All262144. WAV || PINK512. WAV
File name: -
Files of type: [Wa\r & Signal files (“wav.” sig) '] [ Cancel ]

The following figure shows the IMPULSE(POSITIVE).WAYV signal file.

Audiomatica Srl FET 30-03-200517.21.11

00
dBv
200

CLIO -

400}

-600F

800

1000k
20 100 1k 10k Hz 20k
1.000 CLIO |

0600 F
0.200 F

w !
-0.200F

-0.600F

1000k
0.00 1.00 20 30 40 50 6.0 7.0 80 ms 9.0 100
CHA dBY 48kHz 1024 46 88Hz Rectangular Unsmoothed

96 7 SIGNAL GENERATORCLIO 12 QC - USER'S MANUAL



The generator menu also keeps track of the recently generated signal files giving
you instant access to them.

7.11.1 SAVING SIGNAL FILES

The generator menu allows you also to save the current signal present in memory
to file. To do this choose Save Current Signal; the format supported is .wav.

Note: during MLS&LogChirp and Sinusoidal menu operation this function
saves current MLS, Chirp or Sin sweep.

It is possible to generate .wav files also from the FFT, MLS&LogChirp and
Leq measurement menu using the SaveAs function; FFT saves last captured
time data, MLS&LogChirp saves impulse response, Leq saves all captured
data.
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7.12 THE GENERATOR CONTROL PANEL

All the above capabilities of generating and playing signals can be controlled with
an handy stay-on-the-top panel, the Generator Control Panel.

[ Generator Control I&J
Sweep | Settings | File |_ File
Freguency [Hz] All
1031.25 Pink
Time On [ms] _

0.00 Chirp
Time Off [ms] b
0.00 White
CEA Burst
Twao Sin
[¥| FFT Bin Round l Sin J
[C1Hanning Sweeper |
— | | —.
¥ Zotit |
‘> Flay
Sin 1031.25

It is possible to switch between signal on the fly by simply clicking on the dedicated

buttons.
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There are also two buttons to hi-pass and low-pass the generated signal with
selectable edge frequency; here you see an all tones signal high pass filtered
@200Hz.

Pink

- neeme o e I
= VO EEHBELOD® 2|0 € X-| QNN L~ (@ # ik ALk Rd| &| & G
rrrr = = | | Goerotor Control 2
b‘rﬂ I <“3| % & [Rectangular | CHA | dBY | Unsmoothed | 10 ‘ 10 [sweep| settings [Fie | File
- e x [a]a EEEEEEEEEETIET I it i) ST
'
[ ow |

dBy LoPass Freq [Hz] _
Chirp
400 5000.00
MLS
il
White
600 //
L1
b [P
a0, o
-
=
2n.0 50.0 oo 200 500 Tk 2k Hz Sk, 10k 20k, ")) Play

Filename: CHA dBV 48kHz 32768 146Hz Rectangular Unsmoothed HiPass 200,00 LePass 5000.00

Input A di
-50

E.“S.U‘ 0dBV

1000V~ « @) ~| (s (6 = © [48kHz

InputB  dBfs e .
fpout® @B | odBY | as

The filtering applies also to MLS and Sinusoidal menu

11 - ELECTRICAL

PHEEHEODe| =

F- r
@ LogChirp - Frequency Response _.:._”__EI___!!_E;Z_J Generator Control @
Al = & -2 gl | = =
PE= o E| L T| o © cHA | BV ||Unsm_o [Sweep| Sefinos [Fie | e
- v £ I S = IOBEO0OBO@DEBD HiPass Freq [Hz]
100 Sl
0 LoPass Freq [Hz] >
1 5000.00]
100 L
I MLS
Pa
00 EH Sinusoidal (===
wol PE = ¥ & ae om0 one 5| oA | v |Unsmoot
0. . - .
avex @0 H DODZODOEEEE
e Sweeper
1]
— =~
ol =
00 i :
A &3 Play
200 4 .
o
/’ HiPass 200,00 LoPass 5000.00
300 e L
A
-40.0
100 200 50.0 100 200 500 1k Hz 2k 5k 10k 20k
Filename: CHA dBY 1/6 Octave Unsmoothed 48kHz DelayCHA [ms]0.000 D
outh dBfs | oapv A "B BB 1 ggpy 4 s | & (B ¢m Out 1000V v 4 ¢ v| 42 (8 = @ |48kHz

7 SIGNAL GENERATOR 99



There is a third interactive feature of the Generator Control Panel not available

elsewhere. The Sweep tab opens a three bands continuous sweeper that can be
operated with the associated slider.

The normal Coarse control (over the entire frequency band) can be changed
(pressing Ctrl) to a Fine tuning of =£1% centered around actual frequency.

[ Generator Contrel I&J
m Seftings | File | File
1000.00 Al
Hz Pink
Chirp
— MLS
White
CEA Burst
Two Sin
[ Sweeper
‘> Flay
Coarse Sweeping... (Ctrl to Fine)
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8 MULTI-METER
8.1 INTRODUCTION

The Multi-meter is an interactive, real-time, measuring instrument.

It gives CLIO the functionality of a:
- Sound level meter (dBSPL, dBA, dBC)
- Millivoltmeter (V, dBV, dBu, dBr)
- Laser displacement meter (m, dBmeter)
- Laser velocity meter (m/s, dBm/s)
- Acceleration meter (m/s2, g, dBm/s2)
- Frequency counter (Hz)
- Distortion meter (THD, THD+N, IMD) (%, dB)
- Power meter (W)
- Current meter (A)
- L-C-R bridge (H, uF, Ohm)

Recallable simply pressing F4, the Multi-meter has the capability of capturing the
global reference level and the microphone sensitivity;it is rare that you enter
CLIO and don't use the Multi-meter, the information and controls available here are
of invaluable importance during the normal operation of the whole instrument.

8.2 MULTI-METER CONTROL PANEL

Foe] Multi-Meter

[roe |- ]
@ =| Q

¥ -
FY

- Voltage RMS = T CHAS%B Fast — = L 4

rs
-

0500 v

LLRTLY) Yo

Voltage
THD

1.000 v
0.001 =

1.000
0.500

\

\%

Freguency
CrestF

IMD

AB Phase

1031 Hz

301 e
41430 =%

0.02 Deg

1031 Hz
dB
30w

= -]

Filename:

RUMMING ...
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Figure 8.1 Multi-meter control panel
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8.2.1 TOOLBAR BUTTONS

’ Starts the measurement.

Log option

[ Multi-Meter
P~ Q
W ~ log r

When checked data acquisition is logged as an ASCII table.

X Permits execution with the control panel in a minimized state. Only a small stay-
on-the-top display remains visible showing the main parameter measured.

0.775 V

D Stops the measurement. If data logging is active user is prompted to save log
data.

ICD@.If pressed displays all measured parameters. Beyond the main parameter the
multimeter monitors some other quantities as displayed in Fig.8.1.
These are
- THD
- Frequency
- IMD
- IMD2
- IMD3
- Crest Factor (ratio between peak and average value)
- AB interchannel phase (when in stereo operation)
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parameter

Woltage Pressure l
@ Voltage 1

Frequency
THD
IMD
Displacement
Velocity
Acceleration
THD+M
Power

Current

Resistance
Capacitance

Inductance

Selects the main parameter to be measured.
unit

Vi e Vv
— dBY
dBu
dBERel
dBR{A)

Selects the measurement unit. Depends on the selected main parameter.

detector
Selects the detector kind among RMS, AVG, Peak, PeakToPeak. Not applicable to
the LCR meter.
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.

a Captures, when pressed, the actual reading of the Multi-meter as the global
reference level, or microphone sensitivity if Pressure reading is active. See
also CLIO>Options>Units Conversion.

Clicking on its side drop-down menu you inspect its important settings:

|EB|CHA|Fast| A - =

Reset

dBRel Reference Level = 1.000000%
Set dBRel Reference Level

or, if Pressure is selected

bd

|EB|CHA|F35’L| A w 3

Reset

Microphone Sensitivity = 17.0mV/Pa
Calibration Level = 94.0dB

avsgd Control the scale of the meter bar graph.

channel
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- CHA&B | Fast —

= CHA F
CHEB

v CHA&E

Selects the input channel. Not applicable to the LCR meter.

integration
Selects between Fast (125ms) and Slow (1s) integration. Not applicable to the
LCR meter.

filter

— =+ a v & X
— & Flat i
LoPass
HiPass
BandPass

LPFreq: 20000.0Hz
Set LPFreq

HPFreq: 20.0Hz
— Set HPFreq L

Enables Lo-pass and/or Hi-pass brickwall frequency filters on acquired data.
Clicking on the drop-down menu it is possible to choose the filter type and
appropriate cutoff frequencies by means of dedicated menu option.
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8.3 LCR METER

When either Resistance, Capacitance or Inductance is selected as main parameter
to be measured, the Multi-meter enters what is called LCR Meter state. The LCR
Meter is a particular operating mode of the Multi-meter that gives you the
possibility of measuring inductors, capacitors and resistors. This measurement is an
impedance measurement and is carried out in Internal Mode (see chapter 12
for details). The LCR Meter takes control of the generator and, when the
measurement is started, outputs a series of sinusoids of variable frequency in order
to find the best frequency to carry out the measurement. The output frequency can
be displayed (with the magnifier button) together with the measured parameter.
The LCR Meter operates only on channel A, @48kHz sampling.

3 Multi-Meter [E=R E=R

@ - | Qf mnductance H RMS X +| CHA | Fast e -

2 = 703 mH Frequency 3155 Hz

L[
rd

nn 1.0 2.0 30 4.0 5.0

Filename: RUNMING ...
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8.4 INTERACTION BETWEEN THE MULTI-METER AND FFT

The Multi-meter uses the same capture and processing units as the FFT control
panel. To perform a measurement it programs the FFT routines (changing FFT
settings to match its needs) and then effectively starts an FFT measurement in
background.

The two panels can be opened and can work together but FFT always acts as the
master while Multi-meter as the slave. In this situation the Multi-meter window's
title is changed to 'Multi-Meter (FFT slave)' to reflect this new state; the Go and
Stop buttons are disabled as you operate the slave panel from inside FFT,
starting and stopping the reading with the FFT's Go and Stop buttons; the input
channel follows the FFT one while the integration setting become
meaningless; this is because the user has control over FFT averages which
precisely define the measurement integration. Nevertheless, during slave operation,
it is possible to select the displayed parameter and its unit.

During slave operation it is not possible to select LCR operation as the LCR
meter uses different measurement capabilities.

As soon as the FFT control panel is closed it releases Multi-meter from the slave
state; then the Multi-meter is then ready to operate in a stand-alone capacity and
is fully functional as described above.

8.5 MULTI-METER SHORTCUTS
G Starts a multimeter measurement.

T Stops current measurement.

8.6 MULTI-METER FILE TYPES

The registered file extension for Multi-meter measurement data files is '.met'.

et
3‘% Met data file.
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9 FFT, RTA AND "LIVE” TRANSFER FUNCTION

9.1 INTRODUCTION

By selecting the FFT command from the main menu bar, it is possible to carry out
Fourier analysis of the input signal to determine its frequency content using the
Fast Fourier Transform (FFT).

The ability to process two channels simultaneously, to select the appropriate
sampling frequency and the possibility of triggering with respect to the generated
signal make this control panel a flexible and valuable instrument. Finally, there is
also a very useful facility to quickly and easily swap back and forth between the
time and frequency domains.

The FFT processed data coming from the two input channels can be displayed as
narrowbands, octave bands (turning the instrument into what is generally
called a real-time analyzer or RTA) or, referencing one to the other, as live
transfer function (you may also use music as stimulus).

9.2 FFT ANALYZER CONTROL PANEL

Lh FFT e =
’ | | AE < | o A |Rectangu|ar | CHA | dBv |Unsm00thed | 1 | 1
- v $ X @, i | OO& 0 EOE G OEOFHOBONE Al B

i

dBY

-20.0

-40.0

-B0.0

-80.0

-100
o0 200 50.0 a0 200 500 1k Hz 2k Sk 10k 20k

Filename: CHA dBV 48kHz 16384 2.93Hz Rectangular Unsmoothed
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9.2.1 TOOLBAR BUTTONS

P Starts an FFT measurement.
Right-clicking on it you open the associated drop down menu

' v Continue

Event Trigger

It is possible to select:

-Continue. In this mode the measurement is not started from blank but
accumulates with the previously stopped one.

-Event Trigger. If selected the measurement is triggered by an input signal.

Starts an FFT measurement. The icon becomes orange in case either Event
Trigger or Internal Trigger are active.

D Stops the current measurement.

] Selects FFT Narrowband analyzer.

g FeT =0 (E=H =
b | | AfB < | W |Rectangu|ar | CHA | dBv |Unsm00thed | 10 | 10
- re

| D000 0OBOFOB OO @A E

4
2]

dBy

300

-60.0

-80.0

rt MF Ry |
= = f TR TR e W#ﬂ i

-180
.0 200 50.0 1an 200 500 1k Hz 2k Sk 10k 20k

Filename: CHA dBV 48kHz 16384 293Hz Rectangular Unsmoothed
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M Selects RTA (octave bands) analyzer.

g RTA - 1/2 OCTAVE = OB
b| luhma __';‘_j.z| o »j-\| Hanning | CHA | dBSPL | 1/3Octave | 10 | 10
s v+ x (@l @ D0OOGEOHOBO0BODOEOE0 B B
a0.0
dBSPL
0.0
60.0 JI |__,_|'__I|_ | I |_
50.0
400
30.0
100 200 500 1k 2k k. Hz 10k 20k
Filename: centrale rta.fft CHA dBSPL 48kHz 32768 146Hz Hanning 1/3 Octave
A8 Selects FFT “Live” Transfer Function analyzer.
5] FFT - Live Transfer Function = @_@
b| | [y | ] :ﬁ: | Haning | CHAB | dB | t/60ctave | 10 | 10 3.38 -20 (]
< v+ x (dla @ DOROPOEOSNONODNOBOBO0 B B
-10.0 q i | i R 1Y 1]
dBSPL [ 4
200 L | [ 50.0
300 m ! e, Y i P e T e ]
. J L' V-\--..r \ f o e =
o
-40.0 -A0.0
0.0 -100
£0.0 -150
100 200 500 1k 2k k. Hz 10k 20k
- v & I @ & (4]
1.00
Fa
0.600
0.200
iy L e i
-0.200
-0.600
-1.00
5.0 -4.0 3.0 20 -1.00 1] 1.00 20 30 ms 4.0 5.0
Filename: centrale live impulse remov CHA/B dB 48kHz 32768 1.46Hz Hanning 1/6 Octave

i Enters the FFT Settings dialog box.
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3%” Enables the Time Data display. The second graph that is activated behaves as an
oscilloscope and displays the captured waveform correspondent to the last FFT

analysis.
Hee FFT =% ol >
’ | A B < | s |Rectangu|ar| CHA | dBV |Unsm00thed | 1 | 1
- v % I @, | OOZOOONOEEOXROB O6 [ B
0
dEv
-30.0
-60.0
300
-120 =
A N LTI SRS Gt b i
- e REA - 1]
0.0 200 50.0 100 200 500 1k Hz 2k Bk 10k 20k,
- v % I @ e (A
1.00
DBD\S Fa Fay Fay L i Fint .\ Fa Fa'
) AY hY 3 FAAY 3 iR FARY FiLY A\ / Fi
0,200 \ 1 3 I3 Y i1y 713 [N [EERY PR [
\ I3 I3 T 1 FT 3 i1 4 [ [ R JEEAY /
N S W £ WY N W 8 N WY Y Y W A W W A I WY
\f L ] y v ] LI Y/ L ] v/
U S W 2 O 2 S W /2 W2 N W W 0 W W A W A B
S 4 A4 L4 W A4 N Wt N W
-1.00
1] 1.00 20 30 4.0 50 6.0 70 8.0 ms 30 100
Filename: CHA dBY 48kHz 16384 293Hz Rectangular Unsmoothed

“=* Enables the Hold function. Depending on the setting entered in the FFT Settings
dialog box, it is possible to hold either the minimum or maximum value per

frequency point.
* Moves the equal loudness curve up of 1phon.

== Moves the equal loudness curve down of 1phon.

data window

Rectangular @ Rectangular
Hanning
Hamming
Blackman
Bartlett
Flattop

Selects a weighting data window among the following:
- Rectangular (no window)
- Hanning
- Hamming
- Blackman
- Bartlett (triangular)
- FlatTop
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channel display

CH A&B CHA
CHE
@ CHA&B

. — |
Selects the input channel to display among the following:

- Channel A only
- Channel B only
- Channel A&B (both channels displayed in different graphs)

Y scale units

dBV| @ dBY
- dBu

dBRel
dBSPL
dBPa
dBmeter
dBm/s
dBm/s®

dBarmpere

Selects the measurement units.
Note:
- dBRel (with respect to the global reference level; see chapter 8)
- dBSPL, dBPa (for acoustical measurements)
- dBmeter, dBm/s (for laser measurements)
- dBm/s? (for acceleration measurements)
- dBampere (for current measurements)

frequency smoothing
Selects the frequency smoothing in fractions of octave from 1/48 to 1/2 of
octave.

fraction of octave (RTA analyzer only)
Selects between 1/1, 1/3 and 1/6 of octave analysis.

target averages
Inputs the total number of averages. Averaging is controlled by the setting in the
FFT Settings dialog.

number of averages display
Displays the number of the actual average; this number increases during the
measurement unless, while in exponential averaging, the target has already
been reached.
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9.3 FFT SETTINGS

FFT Settings [

General Display

FFT Size |32?53 e Hold function Min @ Max
Freq Axis Logarithmic -
Equal Loudness Contour

Delay [ms] 0

_ Awveraging

ket S Linear @ Exponential

Frequency Calibration
AMSI/CEA-2010

Signal |FILE ,l Enable power test

| Save Settings | oK | | Default | | Cancel |

L

FFT Size
Selects the number of samples acquired and processed by each FFT. It is
possible to choose a size between 512 and 262144 points.

Delay
Permits the input of the desired processing delay (in ms) when in Internal
Trigger mode.

Internal Trigger
Enables the Internal Trigger mode. Each FFT acquisition is then started when the
signal, internally generated by CLIO, begins. Event trigger, see above, instead
triggers on the signal present at input.

Enable Frequency Calibration
Enables frequency calibration to compensate for any hardware non linearity;
frequency calibration, if enabled, takes place only when the generator is active.

Hold Function
Selects either Min or Max hold function. This functionality is activated by the
relative toolbar button.

Freq Axis
Selects from linear or logarithmic frequency axis (valid only for FFT narrowband)

Enable Equal Loudness Contour
Enables the display of the normal equal loudness level curves as defined in the
ISO 226 standard. The curves are displayed only in FFT narrowband and RTA
modes when dBSPL units are selected.

Averaging
Selects either linear or logarithmic averaging.

ANSI/CEA-2010
Enables power test processing as per ANSI-CEA 2010 norm.
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9.3.1 DEDICATED 'LIVE’ SETTINGS AND TOOLBAR FUNCTIONS

FFT Settings e
General Display
FFT Size 32768 »|  Holdfunction © Min @ Max

Coherence Threshold 0
Equal Loudness Contour

Delay [ms] 3.375
: , Aweraging
Multi Resolution j ;
Linear @ Exponential
Freguency Calibration
ANSI/CEA-2010
Signal |FILE v| Enable power test
[ Save Settings| oK ‘ | Default || Cancel |

Coherence Threshold
Selects the coherence threshold to display measured data. If set to zero all data
are displayed. Otherwise only FFT bins with coherence above it will be shown.

Multi Resolution
Enables multiple FFTs (of decreasing length) to cover different frequency bands.

Phase Coherem:e Compression Factor

Y

v \

% & T o (CHAB | dB |1120ctae | 5 | 5 340 20 ° 26

N AN __/

Impulse Delay finder Delay Level Threshold

%Enables the Time Data display. The lower graph displayed is the impulse
response.

T Enables phase response to be displayed in the lower graph.

I" Enables coherence response. The coherence is displayed in the same graph of
the transfer function magnitude and reads on the right displays scale.

l'-"'-‘1Automatically evaluates the interchannel delay and sets it. The value of the
delay is shown in the delay display.

delay display
Shows the delay correction, in ms, that is applied while processing the two
channels.

level threshold display and control
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Sets the peak level versus input full scale of the reference channel below which
the measurement is frozen. It is possible to modify the value using the dedicated
spin buttons. Setting this threshold properly lets you measure only when the
signal is present at the reference channel and avoid that inaccurate readings
accumulates with the measure distorting it.

compression factor display
Shows the difference, in dB, between the crest factors of the two input signals.
The compression factor gives you a rough indication about how much the system
under test is limited in its dynamic range. The more negative the compression
factor more the system is limiting the input signal.

9.4 FFT AND MULTI-METER

There is a close interaction between FFT and Multi-meter operations. The two
measurements share the same acquisition and processing core. Should they
operate together the FFT control panel acts as the master while Multi-meter follows
as the slave. In this situation, among other peculiarities, the Go and Stop buttons
of the Multi-meter are disabled; if an FFT acquisition is started then the Multi-meter
runs as well, the same when you stop the measurement.

9.5 FFT AND Leq ANALIZER

It is possible to execute FFT or RTA analysis while an Leq measurement is taking
place. The following figure shows the analysis of a sample of speech done with Leq
and RTA in parallel.

€ CLIO 11 - ELECTRICAL & ACOUSTICAL TESTS E=REE—
= vl BHEOS F O€ X-| W Ol M M@ (8] ¥ [ 7] el 0| & | & o
[Eq Leq Analysis = f@ s | B rra-1/3 ocTAvE S ==
b:jf;?| = \ cHa | @8sPL || O0h |om [30s | P AfB {53 |»§ | Hamning | GHA | dBSPL | 13
7 Leq a v & T Al - v &£ X = mOoEoE
120 120
9011 dBSPL
100
Ls\ow B
— o LD
90.3 i e e
L 800 [l B W
Fast A [~ .
L
90.6
L user 100
20.0

"

-0.400

l L
-1.20 '| HI

700 -2.00 ”
9.0 9.2 94 96 9810010 10 Ms1 N 1} 50 100 18 20 25 eln} 35 40 ms 45 50

=

68.8 M0 B0 100 200 B0 1k %k Wz Sk 1k 20k
Peak -« v 2 I &, &
200
104.6 w00 P | .
Time s y i
00:00:11 naofy e
ann‘ ' A 1 I 1

Filename: CHA dBSPL 1/1000s A-Weight LUserHistory Filename: CHA dBSPL 48kHz 16384 293Hz Hanning 1

InputA  dBfs
-50 0

20dBy & |0 S | ggBy b | & |qr B Out 1000V - 4 - (s (B @ O |d8KHz

Some limitations apply to FFT settings, in particular it is not possible to select an
FFT size higher than 32768. See also chapter 16.
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9.6 FFT SHORTCUTS

G Starts an FFT measurement.

T Stops current measurement.

S Invokes Setting menu.

F Enters FFT narrowband analyzer.

R Enters RTA analyzer.

L Enters “Live” Transfer Function analyzer.
D Invokes Time Data (Oscilloscope) display.
H Invokes Hold function.

Page-Up Page-Dn
Manually increase or decrease delay by 10ms.

Shift Page-Up Shift Page-Dn
Manually increase or decrease delay by 1 sample.

9.7 FFT FILE TYPES

The registered file extension for FFT measurement data files is ".fft'.

Ht
™ FFT data file.

9.8 FFT ASCII TEXT EXPORT
The following data can be exported in ASCII files (see chapter 5):

Display Frequency Data
The program will export the processed frequency data as they are displayed on
the screen, with its internal resolution of 2048 points, regardless the current FFT
size.

FFT Frequency Data
The program will export the processed frequency data with the resolution of the
current FFT size.

Last FFT Data
The program will export the last calculated FFT frequency data with the
resolution of the current FFT size.

Last Time Data
The program will export the last captured time data with the resolution of the
current FFT size.
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10 MLS & LOG CHIRP
10.1 INTRODUCTION

MLS&LOG CHIRP menu features two different techniques that yield to the final
result, the complex transfer function of a generic device. They are MLS and LOG
CHIRP Analysis. While the internal processing is quite different the result is the
same and this justifies keeping them together.

MLS stands for Maximum Length Sequences, is a powerful well established
technique that allows you to carry out analysis of linear systems recovering the
Impulse Response of the device using a fast cross-correlation algorithm. It is
therefore a time based analysis. Frequency domain information is obtained
calculating the FFT of the Impulse Response.

LOG CHIRP analysis uses a log-swept sine chirp as stimulus. The Frequency
Response is obtained with a deconvolution process and the Impulse Response with
an inverse FFT of the Frequency Response.

With MLS&LOG CHIRP it is possible to measure:

- Impulse Response of any generic DUT

- Complex Transfer Function

- Group Delay

- Quasi-anechoic Frequency Response of a loudspeaker
- Room Acoustic Response

- Step Response

- Schroeder Decay

- ETC (Energy Time Curve)

Within this Menu the user will be able to deal simultaneously with time and
frequency domains using the powerful post processing tools CLIO provides. This
allows the collection of very sophisticated and complete information of any electro-
acoustic device.
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10.2 MLS & LOG CHIRP CONTROL PANEL

@ LogChirp - Frequency Response EI@
| S AR R f\| ] @f ™ b [CHA | dBV  Unsmoothed | de -~ |0.000

- v $ I i | IO0RROEFOONOEEODOEBO O @ @8

0.0

dBY
100

0

-10.0

200

-30.0

100 200 0.0 100 200 500 1k 2k Hz k. 10k

1.00
D.S%
0.600
0.400
0.200

-0.000m

-0.200
-0.400
-0.600
-0.800

-1.o0

1] 24 ] 102 137 171 205 238 273 ms a7

Filename: CHA dBYV Unsmoothed 48kHz 16K Rectangular Start000ms Stop34131ms FreqlO 293Hz Length 341.31ms

10.2.1 TOOLBAR BUTTONS

> Starts an MLS & LOG CHIRP measurement.

] If pressed the measurements will be autosaved. The current autosave definitions

apply (see chapter 5).

e . .
==+ If pressed the measurements will be autostored in overlays.

CJ Selects the Loop mode. When in Loop mode the MLS & LOG CHIRP
measurement is automatically repeated until the user presses a keystroke or
releases the button. If Autosave is active the loop mode ends after the total files

to be autosaved are done.

B When an MLS & LOG CHIRP measurement is taken, it automatically applies the

selected post-process.
T Enters the MLS & LOG CHIRP Process dialog box.
8 Enters the MLS & LOG CHIRP settings dialog box.
IL_ shows Time domain.
“™ Shows Frequency domain.
Z" Shows both Frequency & Time domains.
i Displays phase.

“P‘ Set wrapped or unwrapped phase
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@ Displays group delay.

By right clicking either on phase ® or group delay € button the kind of calculation
can be selected:

|l_T. S rHa |

—— @ Mormal

Minirmurm

’7 Exwcess
I S |

Normal displays the measured phase (group delay) curve referring to the selected
time domain data.

[T

Minimum calculates and displays the phase (group delay) curve, related to the
current modulus curve, in the assumption of minimum phase behavior (i.e. the
Hilbert transform of the log magnitude).

Excess calculates and displays the phase (group delay) curve as the difference
between the Normal and the Minimum ones.

- Displays Impulse Response.
I Displays Step Response.
N Displays Schroeder Decay.

LDispIays Energy Time Curve (ETC).

channel display

CHAl ¢ cHa |
CHE

Selects the input channel to display among the following:
- Channel A only
- Channel B only

Y scale units

dBV | @ dBY

dBu
dERel
dBSPL
dEPa
dBPa/V
dBrneter
dBmys

dBm,s*

dBampere
Ohm
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Selects the measurement units among the following:
- dBV
- dBu
- dBRel (with respect to the global reference level; see chapter 8)
- dBSPL (for acoustical measurements)
- dBPa (for acoustical measurements)
- dBmeter (for laser measurements)
- dBm/s (for laser measurements)
- dBm/s? (for acceleration measurements)
- dBampere (for current measurements)

smoothing
Activates a frequency smoothing of the active curve. This smoothing effect will
allow a better appreciation of the general features of the response curve. The
smoothing algorithm that is employed averages all values within a fraction-of-
octave band surrounding each analysis frequency.

- Automatic delay capture. Based on the current impulse response finds and
mathematically removes the impulse delay. The delay found is displayed in the
nearby box, inside the Impulse Response control panel it also activates Marker B
showing the delay.

@ LegChirp - Frequency Response E@
D= s 3E L r\|® J’ ™\ ke [CHA | dBSPL |Unsmoothed | « ~ 2938

<+ x (a3 TNOPVODOBOBOBONOBO080 B

8a.0

: 180
S N N 1 S o

30.0 B — \\ 1108

[t I, E
75.0 . M i ;0
o 1 N AA T
e R T
700 )
\\
85.0 o~ 108
‘\"!
50.0 180

20.0 50.0 100 200 500 1k 2k Hz Bk, 10k, 20k,

0.1
e
n.os00f--
o.0400f--
0.0200
0.000m
2.0200
2.0400
0.0800
0.0800
0100
0 14 23 41 55 53 23 a7 11 me 12 14

Bx 29375 ms By 01288 Pa Bz 1.0105m

Filename: 1255380 0.mls CHA dBSPL Unsmoothed 48kHz 16K Rectangular Start0.00ms Stop 835ms FreqlO119.70Hz Length 8.35ms

The delay can also be fine tuned or set manually:

clicking the dedicated buttons (in 0.01ms steps)

with Page-up and Page-dn keys (in 0.01ms steps)

with Shift Page-up and Shift Page-dn keys (in 0.1ms steps)
with Ctrl Page-up and Ctrl Page-dn keys (in 0.001ms steps)
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10.3 MLS & LOG CHIRP SETTINGS

MLS Settings &]1
General Averages
Size |1Ek—v 1
@ Continuous
Window @ Manual
Stimuli Impedance
O Mis [7]10hm Right Scale
@ Internal
@ LogChirp QC Box Select
[[] Save Settings | oK ‘ [ Default ‘ [ Cancel ‘

size
Selects the size of the MLS & LOG CHIRP sequence.
Log Chirp size spans from 4k to 2M samples (1M and 2M size are uncalibrated as
are meant to be used for Room Acoustic response measurements)
MLS size spans from 4k to 512k samples.

window

Selects the appropriate kind of window for analyzing time data. It is possible to
select between a rectangular, Hanning or Blackman window; the last two can be
full or half size. NOTE: These windows are applied to the time portion to be
transformed with FFT. If the start point is near the impulse, full windows will
null the most important part of the time response (due to their rise time). To
evaluate the effects of a data window refer to Chapter 9, and FFT measurements
in general.

stimuli
Selects the kind of stimulus, either MLS or Log Chirp used for the measurement.

averages
Controls the averaging mode of operation. The measurement will be repeated
and averaged the number of times set, therefore obtaining a better signal-to-
noise ratio at the expense of reduced measurement speed. Continuous
performs the number of averages in the shortest time without waiting. Manual
waits the user to press any key between each measure; it is useful, for example,
in averaging different microphone positions.

impedance
Set how Impedance is calculated and displayed. When taking impedance
measurements refer either to the Internal impedance mode or to QC Box
Select (the hardware setting of the QC Box determines directly the Impedance
Mode, refer to 4.6). When checking Ohm Right Scale the impedance is referred
to the right Y scale
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10.4 IMPULSE RESPONSE CONTROL PANEL

@ LogChirp - Impulse Response EI@
P E @ § R f\ T |J’ ™ b [CHA | dBV |Unsmoothed ~ ~ |0.000

- v & X NN 4 4+ nO B 6

1.00
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-0.000m

L e
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-l.oo
1] 24 5] 102 137 171 205 239 73 oms 307 4

Filename: CHA dBV Unsmoothed 48kHz 16K Rectangular Start0.00ms Stop341.31ms FreglQ 293Hz  Length 341.31ms

The following buttons inside the measurement area are particular to this control
panel. See Chapter 6 for other general information.

# Selects the starting point of the measurement window.
- Selects the end point of the measurement window.

- Restores the default state of the measurement window thus selecting all the
acquired points for analysis.

[1] EI Stores and displays one impulse response overlay curve

@ Activates marker A and B
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10.5 MLS & LOG CHIRP POST-PROCESSING TOOLS

MLS Processing Tools [_Jﬂ-
v E[F- X+t **RAO S
value |File |

Real 0

Imag 0O

‘ 0K ‘ Cancel

¢/ Loads an MLS & Log Chirp process.

= Saves an MLS & Log Chirp process.

+ Adds a data value or compatible file to the current measurement.

== Subtracts a data value or compatible file to the current measurement.
X Multiplies the current measurement by a data value or compatible file.
= Divides the current measurement by a data value or compatible file.
H Shifts the current measurement by a dB value.

0 Multiplies the current measurement by complex frequency.

dh Divides the current measurement by complex frequency.

?Vw Uses a reference measurement file taken at speaker terminals to calculate 1m
sensitivity in dBSPL/W. The reference file should have dBV Y units while the one
in memory should be in dBSPL.

/M Process the current measurement with an octave band filter. It is possible to
input the mid-band value and the filter bandwidth.

@Temporally shifts the current measurement by a ms value. Affects phase
response.

T Merges the current measurement with the part below the selected transition
frequency of a selected compatible file.

CI Combines the actual measurement and the selected file to obtain a constant
current impedance measurement. Both files should be in dBV.

CH Combines the actual measurement and the selected file to obtain a constant
voltage impedance measurement. Both files should be in dBV.
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10.6 MLS & LOG CHIRP SHORTCUTS

G Starts a MLS & Log Chirp measurement.

m
[72]
(o]

Stops current measurement.
Invokes Setting menu.
Shows Frequency Response.

Shows Time Response.

M -~ M ‘

Shows Phase (in Frequency Response).
Shows Step Response (in Time Response).

(w)

Shows Group Delay (in Frequency Response).
Shows Schroeder Decay (in Time Response)

I Shows Impulse.
E Shows ETC.
10.7 MLS & LOG CHIRP FILE TYPES

The registered file extension for MLS & Log Chirp measurement data files is '.mls'.

The registered file extension for MLS & Log Chirp process files is '.mpro'.

=
1 MLS & Log Chirp data file.

m:E}m
= | MLS & Log Chirp process file.

10.8 MLS & LOG CHIRP ASCII TEXT EXPORT
The following data can be exported in ASCII files (see chapter 5):

Display Frequency Data
The program will export the frequency data as they are displayed on the screen,
with resolution variable from 256 to 2048 points, regardless the current MLS
size.

FFT Frequency Data
The program will export the frequency data with the resolution of the current
MLS size.

Time Data
The program will export the acquired impulse response or active post process.
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11 SINUSOIDAL
11.1 INTRODUCTION

Within Sinusoidal, it is possible to carry out simultaneous analysis of:
- Frequency Response

- Impedance

- Distortion (THD plus harmonics up to 10™)

- Rub&Buzz.

As should be obvious the stimulus used is a sinusoidal signal, stepped or
continuously swept within user defined frequency limits. Although sinusoidal steady
state analysis is among the oldest and more traditional kind of measure, CLIO
merges the reliability of this well known technique with the power of advanced DSP.

The completely programmable Gating feature allows the user to add quasi-
anechoic acoustical frequency response capability.

Simultaneous, two channels, stereo measurements can be performed.

11.2 SINUSOIDAL CONTROL PANEL

EH sinusocidal = |[= ][
D3 = & & B o | THD Dist ReB = [CHASB | dBV |Unsmoothed |
- v $ X FE OOR 3 [ 4 [5] BO0FOBBO0O0O @& B

o0

dB

]

0.0

-20.0

-30.0

-40.0
o0 0.0 0.0 1an 200 500 Tk Hz 2k k. 10k, 20k,

Filename: CHA&B dBV 1/6 Octave Unsmoothed 48kHz DelayCHA [ms]0.000 DelayCHB [ms] 0.000 Distortion Rise [dB] 30.00  SweepTime [ms] 2126.15

11.2.1 TOOLBAR BUTTONS
> Starts the sinusoidal measurement.

Ez_':l]lf pressed the measurements will be autosaved. The current autosave definitions
apply; see chapter 5 for details.

e . .
==+ If pressed the measurements will be autostored in overlays.

B Automatically applies the defined post-process after the measurement has been
taken.
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T+ Enters the Sinusoidal Post-Process Dialog, described b